
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Agilent 遺伝子発現マイクロアレイ 

1x244K、2x105K、4x44K、8x15K、1x1M、2x400K、4x180K、8x60K  

 

Protocol Version 6.9_JP 対応 

[2019 年 9 月改訂プロトコル] 

 

アジレントシュアプリントテクノロジーで製造した DNA マイクロアレイ

 

Research Use Only. Not for use in Diagnostic Procedures.  

アジレント遺伝子発現マイクロアレイ 

2 色法プロトコル 

 

Low Input Quick Amp Labeling Kit 
 



遺伝子発現マイクロアレイ 2 色法プロトコル 2 

目次 

 

1．はじめに ............................................................................................................................................ 3 

 

2．使用するキットの確認 ........................................................................................................................ 5 

 

3. 実験に必要な試薬・消耗品など ......................................................................................................... 8 

 

4．実験に必要な機器・器具 ................................................................................................................... 11 

 

5．実験を始める前に ........................................................................................................................... 12 

 

6．プロトコルの全体図 ......................................................................................................................... 13 

 

7．実験の操作手順 .............................................................................................................................. 15 

 

8. 実験：１日目 .................................................................................................................................... 16 

 

9. 実験：２日目  スライドグラス洗浄の前準備 ..................................................................................... 37 

 

10. Agilent スキャナを用いたスキャニング .......................................................................................... 45 

 

11. ハイブリダイゼーション後のマイクロアレイの画像化 ...................................................................... 54 

 

12. Feature Extraction ソフトウェアで数値化を行う前に .................................................................... 57 

 

13. Feature Extraction ソフトウェアによる数値化 .............................................................................. 60 

 

Appendix1：total RNA の品質チェック ............................................................................................... 71 

Appendix2：サーマルサイクラーを用いた実験プロトコル ..................................................................... 73 

Appendix3：詳細なスキャナの起動手順 ............................................................................................. 74 

Appendix4：Feature Extraction 用デザインファイルのダウンロードサイト ......................................... 75 

Appendix5：Feature Extraction 用 Protocol のダウンロードサイト .................................................. 76 

Appendix6：マイクロアレイのレイアウト ............................................................................................... 77 

Appendix7：弊社 DNA マイクロアレイサポート用ホームページ ........................................................... 78 

  



遺伝子発現マイクロアレイ 2 色法プロトコル 3 

1．はじめに 

 

アジレント・テクノロジーでは、マイクロアレイ実験をされる実務者の方を対象に DNA マイクロアレイ カスト

マニュースを配信しています。実験プロトコルのアップデート・新製品のご案内・実験に関するトラブルシュ

ート・試薬や消耗品の保存など、実験を成功させるためのテクニカルサポートに内容を限定して、E-mail で

お送りしています。受信をご希望の方は「DNA マイクロアレイ カストマニュース配信希望」と明記して、お

名前・ご所属・配信を希望する E-mail アドレスを下記宛先までお知らせください。 

 email_japan@agilent.com 

 

本プロトコルは、アジレント遺伝子発現マイクロアレイを用いた 2 色法解析における、推奨ラベル化、ハイブ

リダイゼーション、洗浄、スキャニングと数値化の手順を記載しています。 

 

2 色法 

 

2 サンプルを 1 アレイにハイブリダイズし、アレイ内のシグナル強度比を測定 

 

 

Ver.6.9_JP での更新点 

⚫ 実験に使用する Agilent キット fragmentation buffer のチューブに含まれる内容量の記載を 

改訂しました。 

⚫ 必要なものリストを見やすくしました。 

⚫ ラベル化 cRNA の NanoDrop による評価の記述を簡便化しました。 

⚫ ハイブリエイドの使い方の絵を一部修正しました。 

⚫ オーブンの写真を型番 G2545A のものに変更しました。 

⚫ Appendix：FE 用 Protocol のダウンロードサイトページの「現在」の日付を 

2017 年 4 月に変更しました。 

 

Ver.6.9 での更新点 

⚫ 保証期間の記述を変更しました。  

Ver.6.7 での更新点 

⚫ 実験上の注意点を追加しました。 

 

mailto:email_japan@agilent.com
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プロトコルは予告なく変更になることがあります。プロトコルを日本語化するにあたり、作業時間が発生する

ため、日本語プロトコルは英語の最新バージョンに比べて、遅れが生じます。製品ご購入の際は、必ず製

品添付の英語版プロトコルの Version をお確かめの上、日本語版が古い場合は、最新の英語版を参照くだ

さい。 
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2．使用するキットの確認 

 

■Low Input Quick Amp Labeling Kit, two-color 48 反応分 

（製品番号 5190-2306） （※本キットは、Cyanine 3-CTP および Cyanine 5-CTP を含みます） 

＜内訳＞ 

• Cyanine 3-CTP および Cyanine 5-CTP （24 反応分チューブ×各 1 本） 

• Low Input Quick Amp Labeling Kit 単品（製品番号 5190-2308、24 反応分 

この製品番号の商品は Cyanine 色素が含まれません。） 

 

Component  Volume 

T7 Promoter Primer 24 µL  

5xFirst Strand Buffer 100 µL  

0.1M DTT 70 µL  

10mM dNTP Mix 20 µL  

AffinityScript RNase Block Mix 36 µL   

5x Transcription Buffer 160 µL  

NTP mix 35 µL  

T7 RNA polymerase Blend 10 µL  

Nuclease-free Water 250 µL  

 

※ 本キットは-20℃で保存してください。 

※ Cy3-CTP・Cy5-CTPは開封前-20℃、融解後4℃で保存してください。実験間隔があく場合は

-20℃でも保存できます。 

※ Cyanine色素のみの販売はしておりません。 

※ 本キットでは10ng~200ngのtotal RNAから、ラベル化反応をスタートすることができます。 

ただし、マイクロアレイのフォーマットにより推奨量が異なりますのでご注意ください（後述） 。 

 

Low Input Quick Amp Labeling Kit, Two-color （製品番号 5190-2306）は、アジレントマイクロ

アレイにあわせて最適化されています。他プロトコルで調製したラベル化サンプルをハイブリダイゼ

ーションに用いた場合、問題の生じるケースがあります。その場合サポート対象外になることをご了

承ください。 

 

■アジレント RNA Spike-In キット（2 カラー用） 

（製品番号 5188-5279） 

Spike A Mix (10uL) 

Spike B Mix (10uL) 

Dilution buffer (1.2mL) 

※全ての試薬は-80℃で保存してください。 
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■アジレント Gene Expression Hybridization Kit 

（製品番号 5188-5242） 

Component 

25x Fragmentation Buffer  (400-500 uL) 

2x GE Hybridization Buffer HI-RPM (1.25mL x 2 本) 

10 x Blocking Agent (凍結乾燥) 

※ 本キットは開封するまでは室温で保存してください。 

※ 10x Blocking Agent を調製した後は、この試薬のみ-20℃で保存してください。 

※ 本キットの使用可能アレイ数は下記のようになります。 

1x244K、1x1M 10 アレイ 

2x105K、2x400K 20 アレイ 

4x44K、4x180K 45 アレイ 

8x15K、8x60K 100 アレイ 

 

※ 下記 2 つの試薬は個別に購入することが可能ですが、Gene Expression Hybridization  

kit (5188-5242)に含まれる試薬の 10 倍量となります。 

2 x Hi-RPM Hybridization Buffer (5190-0403) 

10 x Blocking Agent (5188-5281) 

 

■アジレント Gene Expression Wash Buffer 

Gene Expression 洗浄バッファ 1 4L  （5188-5325） 

Gene Expression 洗浄バッファ 2 4L  （5188-5326） 

■アジレント Gene Expression Wash Pack (5188-5327) 

Gene Expression 洗浄バッファ 1（5188-5325）が 2 個、Gene Expression 洗浄バッファ 2

（5188-5326）が 1 個および TritonX-102 (1.35 mL のチューブ 6 本) のセットです。 

 

■アジレント Stabilization and Drying Solution  -  500 mL 

（製品番号 5185-5979） 

※ オゾンフリーブースがない場合にご使用ください。 

 

 

実験に使用する全ての試薬・消耗品のロット番号と Expiration Date を記録して下さい。お問い合わせ

頂く際はこれらの情報を添えて下さい。 
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  アジレント遺伝子発現マイクロアレイ 

 

1 パック(1M、244K フォーマット)は、 

１枚のスライドグラスに１枚のアレイが載っています。 

 

 

 

1x1M フォーマット 1x244K フォーマット 

                

2 パック（2x400K、2x105K フォーマット）は、 

1 枚のスライドグラスに 2 枚のアレイが載っています。 

 

 

 

2x400K フォーマット         2x105K フォーマット 

 

4 パック(4x180K、4X44K フォーマット)は、 

1 枚のスライドグラスに 4 枚のアレイが載っています。 

 

 

 

4x180K フォーマット         4x44K フォーマット 

 

8 パック(8x60K、8X15K フォーマット)は、 

1 枚のスライドグラスに 8 枚のアレイが載っています。 

 

 

 

8x60K フォーマット 8x15K フォーマット 

 

 

 

必要なソフトウェア 

アレイフォーマット スキャナ スキャンコントロールソフト Feature Extraction 

8x15K, 4x44K, 

2x105K, 1x244K 

B スキャナ、C スキャ

ナ、または SureScan 

v7.0.1 以降 

（SureScan は v9.1） 

v9.5 以降 

8x60K, 4x180K, 

2x400K, 1x1M 

高解像度使用のCスキ

ャナまたは SureScan 

v8.4.1 以降 

（SureScan は v9.1） 

v10 以降 

 

105 K105 K

15K

15K

15K

15K

15K

15K

15K

15K

44K44K44K44K

244 K 1M 

400 K 400 K 

180K 180K 180K 180K 

60K 

60K 

60K 

60K 

60K 

60K 

60K 

60K 
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3. 実験に必要な試薬・消耗品など

アジレント遺伝子発現アレイ実験に必要な消耗品および器具のリスト（実験プロトコル v6.7 対応）  

（2019 年 12 月作成） 

対応マイクロアレイフォーマット：1x1M, 2x400K, 4x180K, 8x60K, 1x244K, 2x105K, 4x44K, 8x15K 

※指定： 必ず指定されたものをご使用ください。指定品以外を使用された場合は保証の対象外になります。 

※推奨： 安定した結果を得るために推奨品の使用をお奨めします。推奨品以外の製品を使用された場合、アプリケーションサポートの 

対象外になります。 

※相当： 備考欄に記載された条件を満たすものなら、他製品をご使用されてもかまいません。 

 

■消耗品（青文字は Agilent 製品です）      問い合わせ先：アジレント・テクノロジー株式会社 (電話 0120-477-111） 
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【マイクロアレイの保管について】 

開封前のマイクロアレイは、室温で保存をして下さい。マイクロアレイのフォイルの袋開封後は、マイクロアレ 

イのスライドは室温の暗所で、真空デシケータか窒素パージしたボックスで保管をしてください。開封後は高湿・ 

温度変化・外気との接触を極力避けて下さい。保管に必要な設備がない場合、全てのマイクロアレイスライド 

は受注製造によって 1 スライドパッケージで納品することが可能です。納期はお問い合わせください。 

 

【試薬・消耗品の保管について】 

Cyanine 3-CTP・Cyanine 5-CTP は、使用するまで-20℃以下での保存を推奨しています。一旦融解して使用を 

開始した後は、凍結融解の繰り返しを避けるために、開封後は 4℃、遮光状態で保管してください。実験間隔が 

あく場合は、-20℃でも保存可能です。 

 

【試薬・消耗品の保証期間について】 

アジレントマイクロアレイおよびその他のアジレント製品の保証期間は、箱やチューブの入った小袋あるいはボト 

ルに記載の Expiration date(Exp. date)までです。保証期間を過ぎた製品については欠品等があった場合も交換 

ができない場合がありますので、製品が納品されたらすぐに内容物を確認して下さい。 

保証期間を過ぎると性能の保証ができないため、保証期間内に使用するように計画して下さい。 
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4．実験に必要な機器・器具 

 

■消耗品（青文字は Agilent 製品です） 問い合わせ先：アジレント・テクノロジー株式会社 (電話 0120-477-111） 
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5．実験を始める前に 

 

＜実験中の注意＞ 

⚫ 実験室内では必ず白衣、手袋、必要に応じてマスク、眼鏡をご着用ください。 

⚫ スライドグラスの縁は鋭利です。手袋をはめ、十分注意して取り扱ってください。 

⚫ 本実験では、毒性のある試薬を使用します。弊社でも留意しておりますが、操作時の安全には、各

自で十分ご注意いただきますよう、お願い申し上げます。 

⚫ 毒性のある溶液に触れたチップやチューブの廃棄場所は、弊社担当者にご確認ください。 

⚫ Cyanine 3-CTP と Cyanine 5-CTP は発癌性物質を含んでいます。吸引、誤飲、皮膚への直接の

接触は避けてください。 

⚫ RNase のコンタミネーションを防ぐために、実験中はパウダーフリーの手袋を着用し、ヌクレアーゼ

フリーの溶液およびピペットチップを使用してください。 

⚫ Cyanine 3-CTP と Cyanine 5-CTP は光で分解します。出来る限り光にあたらないように注意して

使用してください。保管時，反応時は必ず遮光してください。 

⚫ ハイブリダイゼーションバッファには塩化リチウム(LiCl)が含まれています。 

塩化リチウム(LiCl)には中枢神経系への毒性があります。催奇性があり、乳児に悪影響を与える可

能性があります。不妊を誘発する可能性があります。吸入、皮膚接触、誤飲により、害を引き起こし

ます。必ず適切な白衣、手袋、マスク、防護めがね等を着用してください。 

⚫ ハイブリダイゼーションバッファにはラウリル硫酸リチウム(LLS)が含まれています。 

ラウリル硫酸リチウム(LLS)は毒性があり、目、気管器系、皮膚に炎症を起こす可能性があります。 

必ず適切な白衣、手袋、マスク、防護めがね等を着用してください。 

⚫ ハイブリダイゼーションバッファには Triton が含まれています。誤飲により害を引き起こします。また、

目に入った場合深刻なダメージを与えます。 

⚫ Agilent Stabilization and Drying Solution (cat. No. 5185-5979)は、毒性、引火性があります。必ず、

適切なヒュームフード（ドラフト）内で使用して下さい。また、有機溶媒を含んでいますので、HPLC 廃

液およびフェノール廃液と同様な廃棄処理を行ってください。 

⚫ アセトニトリルは引火性と揮発性があります。吸引、皮膚接触、誤飲により肝臓、腎臓、循環器、中

枢神経系害を引き起こします。 

⚫ 実験に使用する全ての試薬・消耗品のロット番号と Expiration Date を記録して下さい。お問い合わ

せ頂く際はこれらの情報を添えて、お問い合わせ下さい。  
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6．プロトコルの全体図 

 

 

 

 

     

RNAtotal RNA 
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ラベル化ステップのタイムテーブル 

 

Step Temperature  Time 

cDNA合成 155 min 

プライマーとテンプレートの熱変性 65ºC  10 min 

急冷 氷上 5 min 

二本鎖cDNA合成 40ºC 120 min 

逆転写酵素の失活 70ºC 15 min 

急冷 氷上  5 min 

cRNA合成 120 min 

cRNA合成 40ºC 120 min 

cRNA精製 30 min 

cRNA精製  RT  30 min 
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7．実験の操作手順 

 

１日目：実験の前準備 

 

• 実験を始める前に、以下のものを準備してください。 

➢ マイクロピペッター（RNA 用） 1-10 uL,10-100 uL,100-1000 uL の３本 

➢ ピペットチップ（RNA 用） 上記各サイズ対応 

➢ チューブ立て 

➢ 1.5 mL チューブ（RNaseFree） 

➢ アイスボックス  

➢ Nuclease-free water 

➢ 96-100％ エタノール 

➢ タイマー 

➢ ボルテックスミキサー 

➢ パーソナル遠心機(スピンダウン用) 

➢ 油性ペン 

 

• あらかじめ使用する機器の温度設定をしておきます。 

➢ ウォーターバスを 37℃または 40℃に設定。cRNA 増幅＆ラベル化反応後 60℃に設定 

➢ ヒートブロックを 65℃、80℃に設定。cDNA 合成後 70℃に設定 

 

• 使用する試薬を解凍しておきます。 

➢ 酵素以外の試薬は、指定がない限り室温より高い熱をかけずにできるだけ早く溶かします。ボ

ルテックスミキサーで撹拌し、5~10 秒スピンダウンして液を底に集めます。 

➢ 酵素は軽くスピンダウンします。 

➢ 全ての試薬は使用直前まで氷上においておきます。 

反応には、Cyanine 3-CTP (10mM) および Cyanine 5-CTP (10mM) を各 0.24 uL ずつ使用

します。事前に反応数を確認し、十分な Cyanine Dye が手元にあるようにします。 
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8. 実験：１日目 

（必ずプロトコルを参照ください。） 

 

8-1. RNA Spike A および B Mix の調製（オプション） 

Spike-In kit に含まれる Spike-Mix を Dilution Buffer で希釈し、希釈物をスタート RNA に添加します。ラ

ベル化に用いるスタート RNA 量によって、Spike-Mix の希釈率が変わります。 

実験に使用する total RNA は、    ng です。下記の表を参照し、以下の手順で希釈します。 

 

1. 37℃、5 分間の加温を行ない、Spike A および Spike B Mix （原液）を溶かします。ボルテックスで混合

し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。以下の手順に従い、Spike A および

Spike B をそれぞれ希釈します。 

2. 1st 希釈液作製: 2uL の Spike A or Spike B Mix に 38uL の Dilution Buffer を加えます（1:20）。 

ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。  

3. 2nd 希釈液作製 : 2uL の 1st 希釈液（Spike A or Spike B）に 78uL の Dilution Buffer を加えます（1:40）。

ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

4. 3rd 希釈液作製  : 2uL の 2nd 希釈液（Spike A or Spike B）に 30uL の Dilution Buffer を加えます

（1:16）。ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

5. 4th 希釈液作製 :    uL の 3rd 希釈液（Spike A or Spike B）に    uL の Dilution Buffer を加えます

（1:    ）。ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

 

注意 Spike Aは Cy3 でラベル化するサンプルに、Spike B は Cy5 でラベル化するサンプルに加え

ます。絶対に間違いの無いようにして下さい。 

注意 Spike-in 量の精度を確保するため、希釈の際は 2 uL 以上の量を扱うようにしてください。 

注意 調製した 1st 希釈液は、‐70 ～ ‐80℃で約 2 ヶ月まで保存できます。さらに 8 回までの凍結

融解を繰り返すことが可能です。2nd、3rd、4th 希釈液は保存、再利用できないので実験の都度

調製します。 

スタート RNA 量 希釈手順 3rd あるいは 4th Spike- Mix の 

必要量(uL)/反応 

total RNA (ng)  PolyA+ RNA (ng) 1st  2nd 3rd 4th 

10 - 1:20 1:40 1:16 1:20 2 

25 - 1:20 1:40 1:16 1:8 2 

50 - 1:20 1:40 1:16 1:4 2 

100 - 1:20 1:40 1:16 1:2 2 

200 - 1:20 1:40 1:16 - 2 

 -  5 1:20 1:40 1:16 1:2 2 



遺伝子発現マイクロアレイ 2 色法プロトコル 17 

8-2. total RNA からのラベル化 cRNA の合成 

Low Input Quick Amp Labeling Kit は、10 ng から 200ng の total RNA または、5 ng 以上の poly A+ RNA

からラベル化 cRNA を合成することができます。 

ただし 

・十分量のラベル化 cRNA を得るためには、4 パック(4x44K および 4x180K)および 8 パック(8x15K および

8x60K)の場合は 25ng 以上、1 パック(1x244K および 1x1M)および 2 パック(2x105K および 2x400K)

の場合は 50ng 以上の total RNA を用いることをお勧めします。 

・得られる total RNA 量が少ない場合は、8 パック使用時のみ 10ng までスタート total RNA 量を下げること

ができます。 

・スタート量の異なる同じサンプルのアレイデータを比較すると、スタート量が多い方が検出できるプローブ

数は多くなります。total RNA 量が十分にある場合は、上記下限量ではなく 100ng 弱～200ng の total 

RNA を用いることをお勧めいたします。 

・RNA 量は一連の実験系では揃えることをお勧めします。 

 

⚫ 反応チューブにサンプル名を書いてください。 

⚫ 1 反応あたりに使用する試薬量は 1uL 以下になるので、必ずマスターミックスを調製後、各チューブに

分注してください。 

⚫ 各マスターミックスは、4 反応の場合は 5 反応分、8 反応の場合は 10 反応分を調製してください。 

 

1. 1.5mL のチューブに、10ng から 200ng の totalRNA を最終量が 1.5uL になるよう加えます。濃度が濃

い場合は希釈してください。 

注意 チューブへの吸着を防ぐために、totalRNA は 100ng/uL 以上で保存してください。 

100ng/uL 以下にする場合は、使用直前に調製しすぐ使用してください。 

2. 各チューブに希釈した 3rd あるいは 4th Spike-Mix を 2uL 加えます。Spike A は Cy3 でラベル化する

サンプルに、Spike B は Cy5 でラベル化するサンプルに間違えないように加えてください。合計 3.5uL

となります。 

注意 total RNA および希釈した Spike-Mix の混合物は 3.5 uL を超えないようにしてください。 

3. 下記表に従い T7 Promoter Primer Mix を調製します。T7 Promoter Primer Mix はラベル化する色素

に関わらず、同一のマスターミックスを用います。例えば Cy3 あるいは Cy5 でラベル化するサンプルが

各 4 チューブずつある場合、10 反応分のマスターミックスを 1 つ調製してください。 

 

注意 ここで使用する水は、必ずラベル化キットに含まれている Nuclease-free water か、

Invitrogen 社の DNase/RNase-free water (10977015)をお使いください。DEPC 処理水

を使用した場合、この後の反応を阻害する恐れがあります。 

  

 1反応分の必要量(uL) 5反応分(uL) 10反応分(uL)
 T7 Promoter Primer(緑キャップ) 0.8 4 8
 Nuclease-free water(白キャップ) 1 5 10
 トータル量 1.8 9 18
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4. 各チューブに T7 Promoter Primer Mix を 1.8uL ずつ加え、ピペッティングあるいはタッピングで良く混合

後、スピンダウンします。合計 5.3uL になります。 

 

5. 65℃で 10 分インキュベーションします（熱変性）。 

 

6. 氷で急冷、そのまま 5 分間冷却します。 

 

7. 5x First Strand Buffer は事前に 80℃のウォーターバスで 3－4 分間温めます。ヒートブロックを使用す

る場合はヒートブロックの well に Nuclease-free water を適量入れ、確実にチューブの底に熱が伝わる

ようにします。ボルテックスでよく混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。使

用するまで室温で置いておきます（氷上に置くと、析出する場合があります）。使用直前に再度析出物が

ないか確認して下さい。ロットによって析出し易い場合があります。室温に戻すとすぐに析出する場合は、

以下の手順で溶解してください。 

a. 5x First Strand Buffer を 80℃のウォータバスで 5 分間加熱し、10 秒以上ボルテックスにかけスピ

ンダウンします。5 分間室温におきます。 

b. 5 分後、析出物が確認されない場合は速やかにマスターミックスを調製します。5 以内に析出物が

確認された場合は速やかにマスターミックスを調製します。 

c. 5 分以内に析出物が確認された場合は再び 80℃のウォータバスで 4 分ほど加熱し、10 秒間ボル

テックスしてスピンダウンします。 

d. 室温におき、5 分以内にマスターミックスを調製します。 

 

8. 下記表に従い cDNA マスターミックスを調製します。ピペッティングで混合し、スピンダウンします。使用

するまで室温に置いておきます。 

注意 AffynityScript RNase Block mix は酵素の混合物です。使用直前まで氷上に置いておきま

す。AffynityScript RNase Block mix を添加後もマスターミックスは氷上ではなく室温に置き、

添加後すぐに使用してください。 

 

1反応分の必要量(uL) 5反応分(uL) 10反応分(uL)  
  5xFirst Strand Buffer(緑キャップ) 2 10 20
　0.1M DTT(緑キャップ) 1 5 10
　10mM dNTP mix(緑キャップ) 0.5 2.5 5
　AffinityScript RNase Block Mix
(紫キャップ)

1.2 6 12

　トータル量 4.7 23.5 47  

 

9. 氷上で冷やしていた各チューブをスピンダウンし、チューブ蓋などについた水滴を落とします。 
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10. cDNA マスターミックス 4.7uL を各チューブに加え、ピペッティングで良く混合し、スピンダウンします。総

量は 10uL になります。 

 

11. 40℃のウォーターバスで 2 時間インキュベーションします。 

12. 軽くスピンダウンした後、70℃で 15 分間インキュベーションし、酵素を失活させます。 

13. サンプルチューブを氷上に移し、5 分間冷却します。 

14. 各チューブをスピンダウンし、チューブ蓋などについた水滴を落とします。 

Note ただちに実験を進めない場合、サンプルを-80℃で保存することができます。 

 

15. 下記表の試薬を上から順に加え、Transcription Master Mix を室温で調製します。 

注意 T7 RNA Polymerase Blend は酵素の混合物です。使用直前まで氷上に置きおきます。

T7 RNA Polymerase Blend を添加後もマスターミックスは氷上ではなく室温に置き、添加

後すぐに使用してください。 

注意 Cy3-CTP 用および Cy5-CTP 用のマスターミックスをそれぞれ調製します。 

 

16. 各 Transcription Master Mix に Cy3-CTP または Cy5-CTP のどちらか一方を加えます。例えば Cy3

あるいは Cy5 でラベル化するサンプルが各 4 チューブずつある場合、それぞれのマスターミックスを 5

反応分ずつ調製してください。 

1反応分の必要量(uL) 5反応分(uL) 10反応分(uL)  
 Nuclease-free water(白キャップ) 0.75 3.75 7.5
5xTranscription Buffer(青キャップ) 3.2 16 32
0.1M DTT(緑キャップ) 0.6 3 6
NTP mix(青キャップ) 1 5 10
T7 RNA Polymerase Blend (赤キャップ) 0.21 1.05 2.1
Cyanine3-CTPまたは
Cyanine5-CTP

0.24 1.2 2.4

　トータル量 6 30 60  

注意 スキャン後の蛍光の色と、色素自体の色が異なりますので、十分に注意してください。 

注意 色素が光にさらされる時間を極力短くしてください。 

  

4.7uL

cDNA合成反応
マスターミックス
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17. 各チューブにそれぞれの Transcription Master Mix を 6uL 加え、ピペッティングで穏やかに混ぜた後、

スピンダウンします。総量は 16uL になります。 

注意 ラベル化するサンプルと色素の組み合わせを間違えないようにしてください。 

 

 

 

18. 40℃のウォータバスで 2 時間インキュベーションします。 

注意 ウォーターバスあるいはヒートブロックにアルミをかぶせ、遮光してください。ヒートブロックを

使用する際、ヒートブロックのウェル形状とチューブが合わない場合は、ウェルに対して水を

少し入れて、チューブ全体へ熱が均一に伝わるようにしてください。 

 

19. ハイブリダイゼーションを引き続き当日中に行う場合には、インキュベーション終了後、以下の設定をし

ておきます。 

⚫ ウォーターバスを60℃に設定 

⚫ ハイブリダイゼーションオーブンを65℃に設定(ローターを取り付けておきます)。 

オーブン庫内が表示温度で安定するまでに 1 時間~1 時間半かかります。 

  

6.0uL

Cy3-Transcription
Master Mix

6.0uL

Cy5-Transcription
Master Mix
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8‐3．Cyanine3-あるいは Cyanine5-ラベル化 cRNA の精製 

StratageneのAbsolutely RNA Nanoprep KitあるいはQiagenのRNeasy Mini Kitを使ってラベル化cRNA

を精製します。この精製ステップにより、ラベル化の際に取り込まれなかったラベル化ヌクレオチド（モノマー）

を除去することができます。モノマーが、ハイブリダイゼーション液中に存在すると、マイクロアレイのバック

グランドの蛍光が著しく高くなります。 

 

⚫ ラベル化cRNAの精製には、Qiagen RNeasy Mini Kitの使用を推奨します。 

⚫ Stratagene Absolutely RNA Nanoprep KitはQiagen RNeasy Mini Kitに比べて溶出量が少ないので、

ラベル化cRNAをより高濃度で精製することができます。少量サンプルからラベル化をスタートした場

合は、Stratagene Absolutely RNA Nanoprep Kitをお勧めします。 

⚫ データの相互比較が必要なプロジェクト内では、精製キットはどちらかに統一することをお勧めします。 

 

【Qiagen RNeasy Mini Kitを用いて精製する場合】 

以下に記載してある手順に従って実験を進めてください(Qiagenのプロトコルを一部変更しています)。 

▪ 使用前に、RPEバッファにエタノール(96-100%)を必要量加えてください。RPEバッファは次のページ

の洗浄ステップで使用します。調製が終わりましたら、フタのラベルのethanolの項目にチェックマーク

を付けてください。 

▪ 全ての遠心のステップは、13,000rpm(10,000g)以上の回転数で行ってください。 

▪ 遠心を4℃で行うことにより、cRNAの収率があがることが確認されております。以下の遠心ステップを

4℃で行うことを強くお奨めします。 

▪ RLTバッファにβ-メルカプトエタノール(β-ME)を加える必要はありません（β-MEが入っていても問

題ありません）。 

 

1. 84 uLのNuclease-free waterをcRNAに加え混合し、液量を100 µLにします。 

 

 

 

 

 

 

 

 

 

2. 350 uLのRLTバッファを加え、混合します。 

 

3. 250 uLのエタノール（96-100%）を加え、ピペッティングで静かに混合します。 

スピンダウンを含め遠心はしないで下さい。 
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4. 700 uLのcRNAサンプルを2 mLのコレクションチューブをつけたRNeasy miniカラムに移します。 

カラムチューブを13,000 rpmで30秒間遠心します。カラムを素通りした液は捨てます。 

 

 

 

 

 

 

 

 

5. RNeasyカラムを新しいコレクションチューブに移し、500 uLの調製済みのRPEバッファ（エタノールが

加えられたもの）をカラムに加えます。カラムチューブを13,000 rpmで30秒間遠心します。カラムを素

通りした液は捨てます。 

 

 

 

 

 

 

 

6. コレクションチューブはそのまま使用し、再度500 uLのRPEバッファをカラムに加えます。カラムチュー

ブを13,000 rpmで1分間遠心します。カラムを素通りした液は捨てます。 

カラムを新しい2 mLのコレクションチューブに移し、13,000 rpmで30秒間遠心し、残っているRPEバッ

ファを完全に取り除きます。 

 

7. RNeasyカラムを新しい1.5 mLのコレクションチューブに移します。 

 

 

8. 30 uL のNuclease-free waterをカラムのフィルター中央に加え、1分間おきます。カラムチューブを

13,000 rpmで30秒間遠心します。カラムを通った液はそのまま残します（液を捨てないように注意して

ください）。 

 

9. チューブは氷上においておきます。使用済みのカラムは捨てます。回収したcRNAの濃度、収量および

品質をUV測定とバイオアナライザを用いて確認します。  
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【Stratagene Absolutely RNA Nanoprep Kitを用いて精製する場合】 

事前準備 

1．80%スルフォランの調製 

 a.100%スルフォランを溶けるまで37℃で温めます。100%スルフォランは室温で固体ですが、80%ス

ルフォランは室温で液体のまま、最低1ヶ月は保存できます。 

 b.1mLのRNase-free水を4mLの100%スルフォランに添加し、5mLの80%スルフォランを調製します。

5mLの80%スルフォランで50回精製できます。 

 

2．1 x High-Salt Wash Bufferの調製 

 a.16mLの100%エタノールを1.67 x High-Salt Wash Bufferに添加します。 

 b.ふたを閉め、よく振って混合します。ふたの1x(Ethanol Added)にチェックを入れます。室温で保存

します。 

 

3．1 x Low-Salt Wash Bufferの調製 

 a.68mLの100%エタノールを5 x Low-Salt Wash Bufferに添加します。 

 b.ふたを閉め、よく振って混合します。ふたの1x(Ethanol Added)にチェックを入れます。室温で保存

します。 

 

精製操作 

遠心は4℃で行ってください。 

1. 100uLのLysis BufferをcRNAサンプルに加え、116uLにします。ピペッティングでよく混合し、ス

ピンダウンします。 

2. 等量（116uL）の80%スルフォランを加え、cRNAサンプルと混ざるまでボルテックスで混合し、ス

ピンダウンします。 

3. RNA-binding nano-spin cupを2mLのコレクションチューブに入れます。 

4. 80%スルフォランとcRNAサンプルの混合物をRNA-binding nano-spin cupに全量移し、

RNA-binding nano-spin cupにキット付属のキャップをはめます。 

5. 12,000g以上で、60秒遠心します。 

6. 遠心後、溶液がRNA-binding nano-spin cupに残っている場合は、素通りした液を捨て再度遠

心してください。溶液が残っていない場合は、カラムを素通りした液は捨て、RNA-binding 

nano-spin cupをコレクションチューブに戻します。 

7. 300uLのHigh-Salt Wash BufferをRNA-binding nano-spin cupに加え、キャップをはめ、

12,000g以上で60秒遠心します。 

8. 遠心後、溶液がRNA-binding nano-spin cupに残っている場合は、素通りした液を捨て再度遠

心してください。溶液が残っていない場合は、カラムを素通りした液は捨て、RNA-binding 

nano-spin cupをコレクションチューブに戻します。 

9. 300uLのLow-Salt Wash BufferをRNA-binding nano-spin cupに加え、キャップをはめ、

12,000g以上で60秒遠心します. 

10. ステップ8およびステップ9をもう一度繰り返します。 
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11. 遠心後、溶液がRNA-binding nano-spin cupに残っている場合は、素通りした液を捨て再度遠

心してください。溶液が残っていない場合は、カラムを素通りした液は捨て、RNA-binding 

nano-spin cupをコレクションチューブに戻します。 

12. 300uLのLow-Salt Wash BufferをRNA-binding nano-spin cupに加え、キャップをはめ、

12,000g以上で3分遠心します。 

13. RNA-binding nano-spin cupを新しい2mLのコレクションチューブに移します。 

14. 20uLのElution BufferをRNA-binding nano-spin cupに加えます。キャップをはめ、室温で2分

間静置します。60℃に温めたElution Bufferを用いると収量が上がります。 

15. 12,000g以上で5分遠心します。 

16. 収量を上げたい場合、ステップ14およびステップ15を繰り返します。ただし、ハイブリダイズに必

要な濃度を下回る可能性があります。 

17. 溶出された液をふた付きのチューブに移します。チューブは氷上におき、回収したcRNAの濃度、

収量及び品質をUV測定とバイオアナライザを用いて確認します。 
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8-4. ラベル化 cRNA の分析 

【NanoDropによる評価】 

通常500 ngのトータルRNAからスタートした場合、2.0 – 4.0 ugのcRNAを合成できますが、トータルRNA

の純度や質(分解度)によっても異なります。合成したcRNA量は、通常のキュベットを使った分光光度計

で測定するには少なすぎる場合がほとんどです。濃度決定に使用するRNA量を最小限に抑えるために、

本プロトコルではNanoDrop分光光度計を推奨しています。 

⚫ NanoDropのソフトウェアを起動し、”Microarray Measurement”のタブを選択します。 

Sample Type は RNA-40 と選択します。 

⚫ 1 uLのヌクレアーゼフリー水で、NanoDropでブランクを設定します。 

⚫ 1 uLの増幅 (ラベル化) cRNAを測定し、A260とA550とA650を記録します。 

 

(1) NanoDrop 計測結果より、cRNA濃度 （ng/uL）を記録します。 

RNA濃度が自動算出されない分光光度計をご使用の場合、A260の値から以下の式で算出して下さい。 

cRNA conc. (ng/uL) * = A260 x 40 ug/mL x dilution factor** 

*光路長10 mmの測定器を使用した場合の式です。ご使用の機器の光路長をご確認下さい。 

**希釈せずに濃度を測定した場合は、Dilution Factorは1を用います。 

 

(2) (1)のcRNA濃度（ng/uL）に溶出量（ 使用した精製キットにより30 ul あるいは20 ul ） 

を乗じ、以下の式でcRNA収量を算出します。 

cRNA yield(ug) = cRNA conc(ng/uL) × 30(uL) / 1000  

 

(3) NanoDrop 計測結果より、CyDyeの濃度 (pmol/ul)を記録します。 

色素濃度が自動算出されない分光光度計をご使用の場合、A550 (Cy3)、A650(Cy5)の値から以下の式で算出し

て下さい。 

Cy3-CTP conc (pmol/ul) * = A550 x 1000 ÷ 150 mM-1cm-1 x dilution factor** 

Cy5-CTP conc (pmol/ul) * = A650 x 1000 ÷ 250 mM-1cm-1 x dilution factor** 

*光路長10 mmの測定器を使用した場合の式です。ご使用の機器の光路長をご確認下さい。 

**希釈せずに濃度を測定した場合は、Dilution Factorは1を用います。 

 

(4) 以下の式で、CyDyeの濃度と取込率を算出します。 

 

Cy3-CTP incorporation (ng/uL) = Cy3-CTP conc.(pmol/uL) ×1000 

cRNA conc. (ng/uL) 

 

Cy5-CTP incorporation (ng/uL) = Cy5-CTP conc.(pmol/uL) ×1000 

cRNA conc. (ng/uL)  
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cRNAの収量およびCy3-CTPあるいはCy5-CTPの取り込み率が下記基準を満たしているか確認します。

基準を満たさない場合には、再度cRNAの調製をされる事をお勧めいたします。ただしスタートtotal RNA量

によっては十分量得られない場合があります。 

また測定した濃度から、マイクロアレイへのハイブリダイゼーションに必要な cRNA 量を計算します。 

アレイフォーマットによって必要量が異なるのでご注意ください。 

マイクロアレイフォーマット 収量(ug) 
Cy3-CTPあるいはCy5-CTP 

取り込み率 (pmol/ug) 

1パック (1x244K, 1x1M) 2.5 6 

2パック (2x105K, 2x400K) 1.875 6 

4パック (4x44K, 4x180K) 0.825 6 

8パック (8x15K, 8x60K) 0.825 6 

 

【バイオアナライザによる評価】 

⚫ 1.5 mLチューブに1.5 uLのラベル化cRNAを分注します。熱変性（70℃2分）を行い、氷上に置きます。 

1 uLをバイオアナライザの測定に用います。 

⚫ バイオアナライザでラベル化 cRNA を泳動する際は、mRNA assay を選択します。 

バイオアナライザの分析例 

 

ラベル化サンプルのシグナルの大部分が、200 から 2000 塩基長のサイズ範囲に位置しているかを確認し

て下さい。これ以外の領域にピークの大部分がある場合、正確なデータが出ない可能性があります。 

バイオアナライザの検出チャネルは Cy5 も励起するため、Cy5 でラベル化したサンプルのデータは Cy3 に

比べてピークが高くなる傾向があり、120nt 付近に高いピークが出ることがあります。 

データ分析時に、ツールバーのアイコン をクリックすると、横軸の表示を秒あるいは nt に切り替え

られます。 

 

ラベル化 cRNA の保存 

cRNA をすぐに使用しない場合には、少量に分注し、暗所-80℃で保存します。長期保存の場合は、チュー

ブに１回分の分量を分注して保存して下さい。 

サンプルの冷凍、解凍のサイクルを繰り返すと cRNA が分解しやすくなります。保管している cRNA の品

質がわからない時は、バイオアナライザおよび UV 計で品質を再確認することをお勧めします。 
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8-5．ハイブリダイゼーションの準備 

⚫ 増幅反応を行っている間に、次のものを準備してください。 

マイクロアレイやガスケットスライド、試薬の Expire date を確認してください。古いものを使用するとノイ

ズが上がる等トラブルが発生する可能性があります。 

➢ アジレント 遺伝子発現マイクロアレイ  

➢ 遺伝子発現ハイブリダイゼーションキット 

➢ ハイブリダイゼーションチャンバ 

➢ ガスケットスライド 

➢ ピンセット（清潔なもの） 

➢ パウダーフリー手袋  

➢ マイクロピペッター（RNA 用） 1-10uL,10-100uL,100-1000uL およびピペットチップ（RNA 用） 

➢ 1.5 mL チューブ（RNase Free） 

➢ チューブ立て（RNA 用） 

➢ 高速遠心機 

➢ ボルテックスミキサー 

➢ アイスボックス 

➢ タイマー 

➢ ウォーターバス（60℃） 

➢ ハイブリダイゼーションオーブン（65℃） 

➢ アジレントチャンバ用ハイブリダイゼーションローター 

⚫ 使用する機器の温度設定を確認しておきます。 

➢ ウォーターバスを 60℃に設定（増幅反応終了後に変更します。） 

➢ ハイブリダイゼーションオーブンを 65℃に設定（ローターを取り付けておきます） 

庫内が表示温度で安定するまでに1時間~1時間半かかります。早めに設定をしておいて下さい。 

≪ハイブリダイゼーションオーブン温度の校正法≫ 

ハイブリダイゼーションの温度はマイクロアレイのシグナル強度やノイズレベルに大きな影響を及ぼしま

す。表示温度と実測値が一致するか 3 ヶ月に 1 度は確認し、0.2 ℃以上異なる場合は下記手順で校正し

てください。 

1. オーブンのローターと、使用するスライド数とバランスをあわせてチャンバをセットします。 

2. 温度を 65℃、回転数を 10 にセットし、温度が安定するまで１時間ほど待ちます。 

3. 校正済みの温度計をセットします。温度センサー部位をとりつけます。この時センサー部位がオー

ブンの壁につかないように、空間の温度を測るようにしてください。 

4. 1 時間程度、温度計の温度が安定するまで待ちます。 

5. 実測温度と設定温度を比較し、0.2 ℃以上異なるようであれば、次の手順で合わせます。 

6. オーブンの ▲ ボタンと ▼ボタンを同時に押し、温度表示が点滅するまで待ちます。あるいは 

▲ ボタンと ▼ボタンを同時に長押し、温度両側の「.」が点滅するまで待ちます。 

7. 点滅しているうちに、▲ボタンと▼ボタンで、表示温度を温度計が示す温度にあわせます。 

8. その後再度表示を 65℃にあわせ１時間ほど待ち、表示温度が実測値と合うか確認します。 

詳細は弊社サポートサイト「Agilent G2535A ハイブリダイゼーションオーブン校正方法」をご覧下さい。 
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8-6. ハイブリダイゼーション 

8-6-1. 10x Blocking Agent の準備 

1. スピンダウンしてペレットをチューブの底に集めます。 

2. Nuclease-free water を 0.5ml, Blocking Agent に加えます。 

※ Large Volume キットをお使いの場合は、Nuclease-free water 1.25 ml で溶解して下さい。 

3. 穏やかにボルテックスをして溶解します。溶解しない場合は 37℃で 4, 5 分温めます。 

4. 5～10 秒スピンダウンし、チューブの蓋や壁についた液を集めます。 

5. 調製した 10x Blocking Agent は-20℃で保存できます。凍結融解が 5 回以内になるように分注して保

存してください。融解後は上記ステップ３、４を行って下さい。 

 

8-6-2. マイクロアレイの取り扱い上の注意 

■マイクロアレイのプローブは、アレイスライドのラベルに”Agilent”の文字が入っている面(アクティブ面)

に載っています。 マイクロアレイスライドに貼ってあるラベルに”Agilent”の文字が入っている方が

Active サイド(プローブが搭載されている側)、数字のみが記

載されたバーコードラベルが付いている面は Inactive サイド

になります。ハイブリダイゼーションを行う際は、アレイがプリ

ントされている Active サイドに、必ずハイブリ溶液が接する

ように注意してください。 

 

■スライドグラスを取り扱う際はパウダーフリーの手袋をはめ、スライドグラスの縁を注意深く持って取り扱

って下さい。スライド表面には両側とも決して触らないで下さい。 

 

■ハイブリダイゼーション開始後は洗浄終了まで、アレイを乾燥させないように注意して下さい。 

 

■ハイブリダイゼーションを行う前に、実験机を整理整頓して下さい。ハイブリダイゼーション器具の周りは

なるべく障害物がない状態を作ってから次ページ以降の操作を行って下さい。 

 

■ハイブリダイゼーションは水平な実験台で行って下さい。下記ハイブリエイドをお持ちの場合は、内蔵の

水準器で水平が確認できます。ハイブリダイゼーション作業を始める前に、予めご確認ください。 

 

■手でアレイスライドをガスケットスライドに乗せるのが難しい場合、オプションとして、ハイブリエイドを用い

てアレイスライドを乗せることが出来ます。 

※ ハイブリエイドはハイブリダイゼーション作業を補助する 

オプションの器具です。  
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8-6-3. フラグメンテーション溶液の調製 

1． 下表に従い、Cy3 ラベル化及び Cy5 ラベル化 cRNA、10x Blocking Agent、Nuclease-free water

および 25x Fragmentation Buffer を 1.5 mL チューブに加え、緩やかにボルテックスをしてサンプル

を十分に攪拌してください。複数のサンプルチューブがある場合は、全てのチューブにラベル化

cRNA、10x Blocking Agent および Nuclease-free water を調製し、最後に Fragmentation Buffer

を各チューブに添加してください。 

1 パックおよび 2 パック使用時に十分量の cRNA がない場合は、合計 1.65ug まで下げることがで

きます。ただし比較したいサンプル同士は同じ量をハイブリダイズに用いてください。 

Fragmentation mix

アレイフォーマット 8パック 4パック 2パック 1パック

Cy3-labeled cRNA 300ng 825ng 1.875ug 2.5ug

Cy5-labeled cRNA 300ng 825ng 1.875ug 2.5ug

10xBlocking Agent 5uL 11uL 25uL 50uL

Nuclase-free water 適量 適量 適量 適量

25xFragmentation 1uL 2.2uL 5uL 10uL

トータル量(マイクロアレイあたり) 25uL 55uL 125uL 250uL
 

 

2. 60℃のウォーターバスで30分インキュベーションします。必ず遮光してください。 

断片化(インキュベーション)が30分を超えない事が重要です。 

3. 30分後、ただちにサンプルを氷水上に移し、1分間冷却します。その後スピンダウンし、断片化をス

トップさせるため、下表に従って速やかに2x GE Hybridization Buffer HI-RPMを加えます。 

各チューブはバッファを加えるまで氷上においておきます。 

注意 以前販売していた2x GE Hybridization Bufferと2x GE Hybridization Buffer HI-RPM

は別の試薬です。必ず2x GE Hybridization Buffer HI-RPMをご使用下さい。 

 

  

Hybridization mix

アレイフォーマット 8パック 4パック 2パック 1パック

Fragmentation溶液 25uL 55uL 125uL 250uL

2xGE Hybridization Buffer HI-RPM 25uL 55uL 125uL 250uL

トータル量(マイクロアレイあたり) 50uL 110uL 250uL 500uL
 

 

4． ピペットでゆっくりと液を混合させます。泡を立てないように十分に気をつけてください。泡が発生し

ますので、ボルテックスは使用しないようにしてください。 

5． 高速遠心機でスピンダウンして(13,000 rpm、1分、室温)、蓋や壁についた液を底に集めます。 

6． サンプルを氷上に置き、直ちにハイブリダイゼーションに使用してください。保存はできません。  
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8-7．ハイブリダイゼーションチャンバの組み立て 

 

ハイブリダイゼーションチャンバを組み立てるにあたり、以下のキットが必要になります。 

 

ハイブリダイゼーションチャンバ (G2534A) 

 

 

 

 

 

 

 

 

 

 

 

 

ガスケットスライド： 

1 パック用 (G2534-60003), 2 パック用 (G2534-60002), 4 パック用(G2534-60011), 

8 パック用 (G2534-60014) 

 

 

 

 

 

 

 

 

 

 

■（オプション）ハイブリエイド 

  

チャンバ－ベ－ス

チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット

チャンバ－ベ－ス

チャンバ－カバ－チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット
プラスチック製
ピンセット

ガスケットスライド 
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1． ピンセットを使ってガスケットスライドのプラスチックカバーの端をつまみ、ゆっくりとはがします。ガスケッ

トスライドをパッケージから取り出します。この時、スライドの縁以外には触れないようにしてください。必

ずパウダーフリーの手袋を着用してください。 

2． チャンバベースの上に、ガスケットスライドを“Agilent”の文字あるいはバーコード番号が書かれている面

を上にして載せます。ガスケットスライドは、ハイブリダイゼーション溶液を介して直接アレイに触れます

ので、ほこり等がつかないようにすばやくセットしてください。 

チャンバベースの 4 つの突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

3． ガスケットスライドがしっかりとチャンバベースにセットされているか確認し、正しくされていない場合は、

再度セットし直してください。 

 

 

 

 

 

4． ハイブリダイゼーション溶液をガスケットスライド上にアプライします。アレイスライドのバーコード番号お

よびアプライしたサンプル位置を記録しておきます。 

アレイフォーマット
8pack
4pack
2pack
1pack

アプライする量(1アレイあたり)
40uL
100uL
240uL
490uL

調製した量(1アレイあたり)
50uL
110uL
250uL
500uL  

5． ハイブリダイゼーション溶液がガスケットのふちまで広がらないように、ガスケットの中央部分にアプライ

してください。スライドグラス上の全てのウェル間で、液面の高さが揃うように、ゆっくりと均等に液を配

置します。 

サンプルをアプライしないウェルがある場合、空白ウェルには、

Nuclease-free water で 1x の濃度に希釈をした GE 

Hybridization Buffer HI-RPMを、アレイのフォーマットに応じて、

上の表の量アプライして下さい。 

（オプションのハイブリエイド用いる場合、ここで p 32 の【参考手

法】を参照下さい） 
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6． アレイ面(Agilent と書かれているバーコード面) を下にして(数字が書かれている方のバーコード面は上

に)、マイクロアレイスライドをチャンバベースにセットされているガスケットスライド上に載せます。このと

き、アレイスライドの縁またはバーコードシール部分を持つようにしてください。マイクロアレイスライドを

水平に保ったままガスケットスライドにのせます。 

アレイを正しくセットした後、チャンバや重なっているスライドグラスを動かさないようにしてください。ハイ

ブリダイゼーション溶液が漏れる原因になります。 

 

注意 2 枚のスライドのバーコードが、正しい位置で重なり合うようにセットしてください。 

チャンバベースの 4 つの突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

 

注意 1 スライドに複数のアレイが搭載されているタイプで、チャンバカバーをセットする前、“サン

プル溶液が接しているアレイ”と“接していないアレイ”があるように見える場合があります

が、問題ありません。アレイスライドを乗せた後は、位置の微調整などは行わず、すぐチャ

ンバカバーを乗せて下さい。 
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※参考手法 

ハイブリエイドを用いることにより、手作業では水平に降ろしづらいマイクロアレイスライドを、サンプルをア

プライしたガスケットスライド上に安定して乗せることが出来ます。 

使用器具： ハイブリエイド (HYB-100) 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

① ガスケットスライドにサンプルをアプライし終

わった時点でチャンバベースの両端から各

ハイブリエイドを差し込み、突き当たるまで動

かします。ガスケットスライドの端を、ハイブリ

エイドの突起部分が覆うような形となります。 

 

② アレイ面(Agilent と書かれているバーコード

面) を下にして(数字が書かれている方のバ

ーコード面は上に)、マイクロアレイスライドを

ハイブリエイド上に乗せます。アレイスライド

の縁またはバーコードシール部分を持つよう

にして下さい。バーコードシール側を先にハ

イブリエイドの上に置き、そこを押さえながら

もう片方をゆっくり下に倒すと作業が容易で

す。チャンバベースの 4 つの突起に当たらな

いように注意して下さい。この時、アレイスラ

イドはハイブリエイドに支えられてハイブリ液

には接していません。 

 

③ 左右のハイブリエイドを同時に引き抜いて下

さい。アレイスライドが水平に落ち、ガスケッ

トスライドと正しい位置で重なります。アレイ

スライドを乗せた後は、位置の微調整などは

行わず、すぐチャンバカバーを乗せて下さ

い。引き抜く先に障害物などが無いようにし

て下さい。 
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7． チャンバカバーを、チャンバベースの上にセットします。カバーの向きを間違えないように注意してくだ    

さい。 

 

8． クランプアッセンブリを、チャンバベースの丸くなっているコーナー側から差し込み、完全にストップする

位置まで移動させます。ストップする位置は、ちょうどチャンバの中央部になります。 

 

 

 

 

 

 

 

チャンバが水平に保たれていることをご確認した後、手でスクリューをしっかり締めます。チャンバにダ

メージを与える可能性があるので、ペンチなどの道具は決して使用しないでください。 

 

 

 

 

 

 

9． 組み立て終了後、チャンバを垂直方向にして 2,3 回、回転させて、ハイブリ溶液がスライドガスケットの

全面に行き渡るようにします。次に、チャンバ内の泡が自由に動くことができるか確認してください。ハイ

ブリ溶液が行き渡っていない部分や、固定している泡によりハイブリむらが起きる場合があるので、泡

が動かない場合にはチャンバを手で軽く振り、泡を移動させます。 

 

10． 残りのスライドも同様に、上記の作業を行ってください。 
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11． チャンバの組み立てが終わりましたら、予め 65℃にセットしたオーブンのローターに差し込みます。ハ

イブリダイゼーション中に外れることがないように、両端をしっかりと差し込んで固定してください。 

複数のスライドグラスをハイブリダイズするときは、必ずローターのバランスをとってチャンバをセットす

るようにしてください。奇数枚の時は、スライドグラスなしでチャンバを組み立て、ローターの対面にセッ

トしてください。 

 

 

 

 

 

 

 

 

 

 

 

 

組み立てたチャンバは、下図 a のようにチャンバのねじが横向きになるように差し込みます（左右どち

らでも構いません）。下図 b のようにねじが正面あるいは背面に向いた状態では、ハイブリダイゼーシ

ョンが不均一となります。 

a.                                         b. 

 

 

 

12． ハイブリダイゼーションオーブンの扉を閉め、回転数を 10 rpm に設定します。 

 

13． 65℃で 17 時間ハイブリダイゼーションさせます。 

 

YES! NO! 

Agilent ハイブリダイゼーション 

オーブン (G2545A) 

ハイブリダイゼーション オーブンロータ 

(G2530-60029) 
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8-8. 洗浄の準備 

 

1.Triton X-102 の Gene Expression Wash Buffer への添加 

Wash Buffer の Expire date を確認してください。古い Buffer を使用するとノイズが上がる等トラブル

が発生する可能性があります。Expire Date が不明の場合は、Expire Date を調べますのでロット番号

を弊社にお知らせください。 

 

最終濃度 0.005%になるように、Triton X-102 を Gene Expression Wash Buffer1 と 2 に添加するこ

とで、マイクロアレイの洗浄におけるアーティファクトの可能性を軽減することができます。 

 

10% TritonX-102 は Gene Expression Wash Pack (5188-5327)に含まれています。単体でもご購入

いただけます(50mL、5185-5975)。 

 

Gene Expression Wash Buffer 1 と 2 の開封時に、以下の方法で 10% Triton X-102 を加えます。 

この操作は、Wash Buffer１と 2 両方行います。 

開封時に添加すれば、その後洗浄時に添加する必要はありません。 

 

1）.ダンボール箱中の容器の、外蓋と中蓋を注意深く開ける 

2）.ピペットで 2mＬの 10％ Triton X-102 を容器中の Wash Buffer に加える 

3）.中蓋・外蓋をきっちり戻し、5・6 回容器全体を転倒混和して、注意深くかつしっかり混ぜる。 

4).中蓋・外蓋を外し、Buffer に添付の蛇口を取り付ける 

5).Wash Buffer の容器に『Triton X-102 添加済』と記載し、日付を記録する 

 

Gene Expression Wash Buffer 中の Triton X-102 の最終濃度が 0.005%になれば、開封済みのより

少ない量の Buffer にも添加することができます。 

 

 

2. Wash2 の保温 

洗浄前日から、Gene Expression Wash Buffer 2とスライドグラス洗浄用ガラス容器(1個)を37℃で

保温しておきます。Wash Buffer 2 は白い箱ごと加温することをおすすめします。37 ℃のインキュベ

ータに入らない場合は、必要量の Wash Buffer 2 を蒸発を防ぐため必ず密閉容器に入れて温めてくだ

さい。インキュベータの表示温度と実測値が一致するか定期的にご確認ください。 
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9. 実験：２日目  スライドグラス洗浄の前準備 

⚫ 洗浄を始める前に、以下の機器・器具を準備してください。 

➢ スライドグラス洗浄用ガラス容器（中 3） 

➢ スライドラック(サーモエレクトロン 109) 

➢ スターラー（2） 

➢ 回転子（ラック小（サーモエレクトロン 109）の場合 3.0cm 程度のもの 2 個 

ラック中（サーモエレクトロン 113）の場合 4.5cm 程度のもの 2 個）  

※回転子の大きさが十分でない場合、洗浄力が弱くなる恐れがあります。 

➢ タイマー 

➢ ピンセット 

➢ パウダーフリーの手袋 

パウダーフリーの表示があっても、蛍光を持つ粒子が手袋についている場合があります。事前

に、確実に手袋から微粒子が発生しないことをご確認ください。ビーカーに入れた洗浄バッファ 

1 で手袋を事前に洗い、手袋から垂れる洗浄バッファが白濁していないこと、および手袋をあら

った後の、ビーカー内の洗浄バッファに微粒子がないことを確認してください。手袋から発生す

る微粒子は、アレイの表面に吸着して結果に大きな影響を及ぼします。なるべく手袋を洗浄バ

ッファに浸さないで操作することをお勧めします。 

 

スライドグラスの洗浄操作 

洗浄条件 

1. オゾンフリーブースを使用している場合はスイッチを入れます。スキャンがおわるまでスイッチは切らな

いでください 

注意 性能を保つため、オゾンフリーブースのチャコールフィルタは年に一回は交換してください。 

 

2. 以下の洗浄バッファを用意します。 

A ： 洗浄バッファ 1: Agilent Gene Expression Wash Buffer 1 

B ： 洗浄液バッファ: Agilent Gene Expression Wash Buffer 2（37℃で保温してあるもの） 

37℃のウォーターバスまたはオーブンで洗浄バッファ 2 を加温します。洗浄直前時まで 37℃で保

温して下さい。弊社では、37℃で保温可能なスターラー付恒温槽（アズワン株式会社（1-5088-01、

P38 の写真参照）あるいは株式会社日伸理化 SW-500NT）の利用を推奨しております。 

 

洗浄バッファの Expire date を確認してください。古い洗浄バッファを使用するとノイズが上がる等トラ

ブルが発生する可能性があります。 

ガラス容器 洗浄バッファ 温度 用途  洗浄時間 

1 1 RT ガスケットスライドと 

アレイスライドの分離 

2 1 RT 洗浄 1min 

3 2 37℃ 洗浄 1min 
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注意 オゾンフリーブースなどのオゾン対策をしていない場合、以下 C・D も用意します。 

また S&D 溶液の取り扱いについては次ページをご参照下さい。 

C ： アセトニトリル：下記 S&D 溶液を使う場合のみ使用します。ドラフト内で扱ってください。 

D ： S&D 溶液：Agilent Stabilization and Drying Solution ドラフト内で扱ってください。 

 

 

≪Agilent S&D 溶液取り扱い方法≫ 

Agilent S&D 溶液はアセトニトリルに溶解させたオゾン除去剤を含みます。オゾン除去剤は飽和状態

になっているため、沈殿物を生じる場合があります。目に見える沈殿があった場合には、以下の手順

で溶液を加温して、沈殿物を再溶解してください。 

 

注意 Agilent S&D 溶液は、揮発性、引火性の溶液ですので、取り扱いに注意を要して下さい。 

警告 警告に従わず火事、爆発による個人的な傷害を負った場合、アジレントの補償対象外になりま

すので、充分注意して取り扱って下さい。 

警告 S&D 溶液の加温は必ず下記の方法に従って行ない、インキュベーター(孵卵器)などでは行わ

ないでください。インキュベーター(孵卵器)などを使用して密閉空間で加温すると溶剤であるア

セトニトリルが気化して充満し、爆発事故や高濃度のアセトニトリルの吸引による健康被害の原

因となる可能性があります。 

 

 ≪S&D 溶液加温手順≫ 

必ず下記手順に従って加温してください。 

注意 S&D 溶液を扱う際は、火気は厳禁です。また電子レンジ（オーブン）は使用しないで下さい。温

度を急激に上げないで下さい。さらに、引火性物質を近くに置かないで下さい。 

① ヒュームフード（ドラフト）内で 37-40℃のウォーターバスを用いてゆっくりと溶液を加温します。 

S&D 溶液はビニル袋に入れてからウォーターバスに入れると、ラベルがはがれません。十分な空気

のヘッドスペース容量がある容器に溶液をいれ、密閉した状態で加熱してください。 

注意  出荷時に S&D 溶液が入っていたオリジナル容器は加温にお使いいただけます。オリジナル

容器は 700 mL サイズで、500 mL の溶液が入っています。オリジナルと異なる容器を使う場合には、

この空気部分のヘッドスペースと溶液の割合がオリジナル時以上になることをご確認ください。沈殿

物を完全に再溶解させるのに必要な時間は、沈殿物の量によって異なります。沈殿量が多い場合に

は、オーバーナイトでの加温が必要になることもあります。S&D 溶液は決してろ過しないでください。 

② 溶液を均一に溶解するために、緩やかな攪拌が必要になる場合があります。必要に応じて、ヒュー

ムフード(ドラフト)内で火気を避けて行ってください。 

③ 沈殿が溶解しましたら、室温に戻してから使用してください。洗浄に使用する際は、マニュアルの詳

細に従って、ヒュームフード（ドラフト）内で行って下さい。 
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3. 下記の通り、3 つあるいは 5 つの洗浄用ガラス容器を準備します。それぞれのガラス容器は回転子やラ

ックを入れた状態で各 Wash Buffer で共洗いをしてください。 

 

■オゾンフリーブースがある場合は、オゾンフリーブース内で洗浄の準備・作業を行ってください（アセ

トニトリルおよび S&D 溶液は必要ありません）。 

■オゾンフリーブースがあり、アセトニトリルおよび S&D 溶液を使わない場合は洗浄をヒュームフード

内で行う必要はなく、またガラス容器は 3 つ準備します。 

■アセトニトリルおよび S&D 溶液を使う場合は、洗浄をヒュームフード内で行って下さい。 

注意 ハイブリダイゼーションチャンバの分解を始める前に、すべての必要な洗浄液とガラス容器の

準備を行ってください。洗浄・乾燥のステップは、できるだけ効率的に行って下さい。 

注意 注意深く洗浄プロトコルに従ってください。また指定の器具を使用してください。洗浄時間を守

ることは非常に重要です。洗浄時間がプロトコルの時間から外れた場合には、結果がばらつ

いてしまう場合があります。また、スライド洗浄を行う際の攪拌には、シェーカーを使わずに、

必ずマグネットスターラーを使用して下さい。 

 

以下のようにガラス容器を 3 個あるいは 5 個用意します。 

ガラス容器 1: 洗浄バッファ 1、 ガスケットの解体用。 

ガラス容器 2: 洗浄バッファ 1、 スライドラックと回転子を中に入れておきます。 

ガラス容器 3：洗浄バッファ 2（37℃に保温したもの）、 回転子を中に入れておきます。 

スターラー付恒温槽がある場合には、37℃に設定して、ガラス容器 3 をセットします（写真参照）。 

注意 スターラー付恒温槽を利用しない場合、洗浄バッファ 1 の洗浄を開始するまで、37℃で保温し

てある洗浄バッファ 2 を加えないで下さい。 

 

 

注意 オゾンフリーブースなどのオゾン対策をしていない場合、以下容器 4・5 も用意します。 

ガラス容器 4：アセトニトリル（S&D 溶液を使うときのみ使用）、回転子を中に入れておきます。 

ガラス容器 5：S&D 溶液（オプション）、回転子を中に入れておきます。このガラス容器は S&D

溶液専用にすることをお勧めします。 

 

4. オーブンからハイブリダイゼーションチャンバを取り出します。複数のスライドをハイブリダイゼーションし

ている場合も、チャンバは必ず１つずつ取り出すようにしてください。泡が形成されているか、また泡が

自由に動いているか確認してください。 

  

 

スターラー付恒温槽 
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0 min 5 min

15 min 30 min

注意 チャンバをオーブンから取り出し、室温で静置すると、放置時間に応じて、ハイブリ液の覆って

いる部分と気泡の部分で、シグナル強度に差異を生じます（下図参照）。オーブンから取り出し

たチャンバは、必ずすぐに解体し、アレイスライドを洗浄バッファ 1 中のスライドラックに移すこと

が重要です。また複数枚のスライドを一度に洗浄する場合も、1 スライドずつ取り出し、解体の

直前まで、規定の温度に保温されていることが重要です。 

5. チャンバを水平な台の上に置き、スクリューを逆時計回りにまわしてゆるめます。 

6. クランプアッセンブリを外し、チャンバカバーを取り除きます。 

7. チャンバベースから、重なっている 2 枚のスライドを同時に取り出します。この時、スライドの両端をしっ

かりつかむようにしてください。すぐに、アレイスライドを上にし（数字が書かれているバーコード面を上に

して）、2 枚のスライドが重なっている状態でガラス容器 1 内の洗浄バッファ 1 に入れます。この時なるべ

く手袋が洗浄バッファ 1 に浸からないようにしてください。 

8. 2 枚のスライドが完全に洗浄バッファ 1 に浸かった状態で、スライドのバーコード側から 2 枚のスライドを

離します。フラットピンセットを用いることにより、洗浄液に手袋を浸さないでアレイを洗浄することができ

ます。フラットピンセットがない場合は、参考手法の手順に従ってください。 

使用器具： フラットピンセット 33A (品番は p.9 参照)  

注意 丸い部分の半分以上でガラスを持たないよう注意が必要。 

 

①2 枚のスライドをピンセットで挟み、 ②バーコード側のピンセットを ③両手でスライドグラスを 

 立てた状態でガラス容器１に入れる。 2 枚のスライドグラス間に入れ しっかりはさみ、 

 アレイ面を傷つけないように ガラス容器 2 中の 

  ガスケットスライドをはがす。 ラックに運ぶ。 

 

 

 

 

 

 

 

 

  

1 2 3

室温放置の影響を検証したデータ 
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注意 スライドグラスを扱う時は、バーコード部分かスライドグラスの縁を持つようにします。決してマイ

クロアレイに触れることがないように注意してください。できる限り洗浄バッファにアレイが浸った

状態で操作し、アレイが空気に触れる時間を最小限に押さえてください。 

 

※ 参考手法 フラットピンセット 33A がない場合は、下記方法で 2 枚のスライドグラスを離します。 

2 枚のスライドが完全に洗浄バッファ 1 に浸かった状態で、スライドのバーコード側から 2 枚のスライドを

離します。 

1) チャンバに付属の白いピンセットの先端を２枚のスライドの間

に差し込み、ゆるやかにピンセットを上側か下側に回転させ

てスライド同士を離します。 

2) ガスケットスライドのみを容器の底に落としてください。  

3) アレイスライドをすばやく取り出し、洗浄バッファ１を入れたガラス容器 2 にセットされているラックにそ

っと差し込みます。 

注意 必ずパウダーフリーであることを確認した手袋をご使用ください。パウダーフリーの表示があっ

ても粒子がついている場合があります。これらの粒子が洗浄バッファに混入すると、洗浄中にア

レイに吸着し、スペックルとしてアレイに残る恐れがあります。 

 

9. 残りのチャンバも同様に解体して、すべてのスライドをラックに差し込みます。一度に洗浄するスライドは

8 枚以下にするようにしてください。 

注意 スライドグラスをラックに差し込む際は、洗浄の効率を保つ持つために端は 3 つ以上、スライド

グラス間は 2 つ以上空けてください。19 スライドラックは最大 5 枚、30 スライドラックは最大 8

枚洗浄可能です。全てのスライドで、アレイ面がラックの中心を向く向きに揃えます。 

 

19 スライドラック(Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ109) 30 スライドラック（Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ113） 

 

 

 

 

 

 

 

10. すべてのスライドグラスをスライドラックにセットできたら、スターラーで中程度の回転数で、室温のま

ま１分間 攪拌します。 

注意 アレイスライドおよびスライドラックを入れた状態で、液面が波立つ程度の速さで攪拌してくださ

い。スライドグラスの枚数、液量によって回転数は異なるので、その都度調節してください。回転

速度が十分でない場合、洗浄力が弱まる恐れがあります。 

注意 スターラー付恒温槽を利用しない場合、洗浄バッファ 1 でスライドグラスを洗浄している間に、ガ

ラス容器 3 に 37℃で保温してある洗浄バッファ 2 を注ぎます。  
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11. スライドラックを 37℃の洗浄バッファ２（ガラス容器 3）にすばやく移します。中程度の回転速度（液面が

波立つ程度の速さ）で 1 分間 攪拌します。実験を成功させるために、この洗浄時間を厳守してくださ

い。 

 

※ オゾンフリーブースなど、S&D 溶液以外のオゾンによる Cy5 蛍光退色の対策が行われている場合 

12. スライドラックを極めてゆっくりかつ一定の速度で洗浄バッファ 2 から引き上げます。スライドラックをで

きるだけ水平に保ったまま、5-10 秒ほどかけてゆっくりと一定の速度でスライドラックを引き上げてくだ

さい。スライドラックを溶液から出したり戻したりしないように注意してください。このステップで洗浄は終

了です。スキャンを行って下さい。 

 

※ オゾンによる Cy5 蛍光退色の対策として S&D 溶液を用いる場合 

13. 洗浄バッファ 2 からスライドラックを取り出します。この時、少しだけスライドラックを傾け、ラックから洗

浄バッファ 2 をできるだけ除きます。洗浄バッファ 2 のアセトニトリル、S&D 溶液への持ちこみは最小

限にして下さい。アセトニトリル、S&D 溶液を含むガラス容器 4、5 は、あらかじめスターラーが少し回

転している状態にしておきます。できるだけすばやくスライドラックをアセトニトリルが入ったガラス容器

に移動させることが重要です。その後、ラックを移したアセトニトリル中で、室温、10 秒間攪拌します。

回転速度は中程度あるいはそれよりも強い程度（液面が波立つ程度の速さ）にします。 

 

14. アセトニトリルからスライドラックを取り出します。できるだけすばやくスライドラックを S&D 溶液が入っ

たガラス容器に移動させて下さい。その後、S&D 溶液中で、室温、30 秒間攪拌します。回転速度は中

程度あるいはそれよりも強い程度（液面が波立つ程度の速さ）にします。 

注意 ラックを S&D 溶液の中に置いた時、白濁が数秒の間生じる可能性があります。これはラック

から持ちこされた洗浄バッファ 2 によるもので、パフォーマンスには影響しません。 

 

15. スライドラックを極めてゆっくりかつ一定の速度で S&D 溶液から引き上げます。スライドラックをできる

だけ水平に保ったまま、5-10 秒ほどかけてゆっくりと一定の速度でスライドラックを引き上げてください。

スライドラックを溶液から出したり戻したりしないように注意して下さい。スライドラックを取り出すのが

早すぎる場合、スライドグラス上に白い粒子が生じることがあります。その場合には、直ちにスライドラ

ックを S&D 溶液中に沈めて、再度極めてゆっくりかつ一定の速度で取り出してください。 

注意 S&D 溶液の滴がスライドラック下側のスライドグラスの端に残る場合がありますが、オリゴ

DNA がプリントしてあるアレイエリア内に液滴がなければ、問題ありません。決してスライド

を振らないで下さい。スライドグラスのアレイエリア内に滴がついている場合は、すぐにスライ

ドラックを S&D 溶液に再度浸し、それから再度極めてゆっくりとかつ一定の速度で取り出し

てください。 
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16. この操作でスライドグラスは乾燥しますので、その後ただちにスキャンを行うことができます。すぐにス

キャンをしない場合には、窒素パージして暗所で保管してください。必要でしたらスキャン後に、スライ

ドグラスはポリプロピレンスライドボックスに入れ（コルクなどの詰め物をしないでください）、真空デシ

ケータまたは窒素パージボックスに入れて暗所で保存します。真空デシケータの方が色素の退色が

見られるため、窒素パージボックスをお勧めしています。 

注意 S&D 溶液には、オゾン除去剤が含まれていますが、長時間のオゾン暴露によりシグナルは

退色していきます。オゾン暴露を最小限にするために、洗浄とスキャンは早朝または夕方の

遅い時間に行ってください。大気中のオゾン濃度は日中、特に交通量が多い時間帯に最大

になります。弊社のスキャナをお使いいただく場合には、一度にセットするスライドグラスを

10 枚までにしてください。このようなスキャニグ操作を行うことで、大気中のオゾン暴露を最

小限にすることが可能です。 

スキャン中の退色をより確実に防ぐ場合は、P.44 のオゾンバリアスライドカバーをご利用くだ

さい。 

S&D溶液およびアセトニトリルの繰り返し利用回数は3 回までにとどめて下さい。ただし繰り返し利用でき

る回数は、洗浄バッファ 2 の持ちこみ量によって異なります。 

 

≪ガラス容器およびチャンバの洗浄法≫ 

洗浄に使用するガラス容器やラック、回転子等はマイクロアレイの洗浄専用にしてください。使用後は洗

剤を使わずに水洗いをしてください。洗剤が残っている器具を使用すると、マイクロアレイに洗剤が付着し

蛍光を発する場合があります。 

1. チャンバ、ガラス容器、回転子およびラックを水道水ですすぎます。汚れが気になる場合は、洗剤がつ

いていないスポンジあるいはキムワイプ（ペーパータオルは使用しないでください）でこすってください。 

2. 超純水でよくすすぎます。5 回ほどすすいでください。 

3. 埃がつかないように乾燥させます。 

 

≪ガラス容器などのメンテナンス≫ 

正しく操作されていても、汚れが洗浄器具に蓄積されるとアレイスライドに影響がでることがあります。 

スキャン画像にムラや粒上の汚れが観察されるなどの問題が起こった場合は、洗浄器具をクリーニング

すると改善する場合があります。以下の手順に従い、クリーニングをしてください。 

ガラス容器の洗浄には、アセトニトリルあるいはイソプロパノール（IPA）を用います。 

アセトニトリルは劇物なのでドラフト内で使用するなど取扱いにご注意ください。 

1. ステンレスラック、スターラー、使用している場合はピンセットなどの洗浄器具をガラス容器に入れ、ア

セトニトリルあるいは IPA を満たした状態で 5 分～数時間おきます。 

2. アセトニトリルあるいは IPA を廃棄した後、ミリ Q 水で洗浄器具全てを徹底的に５回以上リンスしてくだ

さい。 

3. 洗浄器具をホコリがつかない環境で自然乾燥してください。 
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≪S&D 溶液の保存≫ 

ヒュームフード（ドラフト）内で手袋を着用し、S&D 溶液を密閉できる褐色または透明なガラス容器に移しま

す。液を移した後、少なくとも 30%以上のヘッドスペースがある大きさのガラス容器をお使いください。漏斗

を使用すると、簡単に溶液を移すことができます。S&D 溶液を移した褐色あるいは透明なガラス容器は、

暗所で保存して下さい。S&D 溶液は初回使用後、2 回まで、合計 3 回まで繰り返し使用できます。S&D 溶

液の繰り返し使用を終了した後は、HPLC 廃液およびフェノール廃棄と同様の方法にて揮発性の溶剤とし

て処分して下さい。 

 

≪S&D 溶液を使用したガラス容器およびチャンバの洗浄法≫ 

洗浄に使用するガラス容器やラック、回転子等はマイクロアレイの洗浄専用にしてください。 

アセトニトリルあるいは S&D 溶液と接した器具は、ヒュームフード（ドラフト）内で手袋を着用し、アセトニトリ

ルを使って洗浄します。その後、チャンバや洗浄バッファ用のガラス容器と同様に、超純水でさらによく洗浄

して下さい。 

使用後は洗剤を使わずに水洗いをしてください。洗剤が残っている器具を使用すると、マイクロアレイに洗

剤が付着し蛍光を発する場合があります。 

1. チャンバ、ガラス容器、回転子およびラックを水ですすぎます。汚れが気になる場合は、洗剤がついて

いないスポンジあるいはキムワイプ（ペーパータオルは使用しないでください）でこすってください。 

2. 超純水でよくすすぎます。5 回ほどすすいでください。 

3. 埃がつかないように乾燥させます。 

 

≪ミリ Q システムのメンテナンス≫ 

ガラス容器などをミリ Q 水でリンスする際、高い水質であることを確認してください。ミリ Q システムのフィル

ターや UV ランプなどの使用期限が過ぎていると水質が悪くなり、ガラス容器などを介し、洗浄したスライド

グラスに影響を与えることがあります。 

参考値: 比抵抗 18.2MΩ･cm, TOC<4 
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10. Agilent スキャナを用いたスキャニング 

レーザーを安定させるために、スキャンを開始する20分前までにPC、スキャナおよびスキャナコントロール

ソフトをこの順に起動しておきます。詳細な手順は、Appendix3 を参照してください。 

 

1. スキャニングの準備 

1. スライドをスライドホルダにセットします。スライドホルダをカローセルにセットした際に、数字のバーコ

ード面が見えるような向きで挿入します。 

a. B スキャナまたは C スキャナをお使いの場合 

 

 

 

 

 

 

 

 

 

 

≪オプション：オゾンバリアスライドカバーの使用≫ 

オゾンバリアスライドカバーを使用すると、スキャン中のオゾンによる蛍光色素の退色を抑えることができ

ます。下図のように、スライドホルダに挿入したアレイスライドに重なるように、オゾンバリアスライドカバー

を置き、スライドホルダのカバーを閉めます。 

⚫ スポット面を傷つける恐れがあるので、オゾンバリアスライ

ドカバーの向き（裏表、左右の向き）に気を付けてください。 

⚫ スキャン中の退色のみに有効です。洗浄・乾燥時の退色は

オゾンバリアスライドカバーのみでは防ぐことはできません。 

⚫ オゾンフリーブースをご利用の場合は、使用する必要はあり

ません。 

 

 

b. SureScan をお使いの場合 

  

 

 

 

 

 

① スライドホルダのカバーを開けます。 

② Agilent’と記載の面がホルダの上側になるように、’Agilent’の文字が奥側になるようにスライドを載せ

ます。  

② スライドを載せます。 

“Agilent”と記載の面が 

ホルダの上側にくるように挿入 

アレイ面 

ラベルが手前、 

“Agilent”と記載の面 

がホルダの上側に 

くるように挿入 

 奥のつめにのせる 

① カバーを開けます。 



遺伝子発現マイクロアレイ 2 色法プロトコル 46 

③ スライドホルダのカバーを閉めます。閉める際カチッと音がし、固く閉まっていることを確認して下さい。

カバーのしまりが緩い場合は他のホルダを使用してください。スライドホルダは 1 台のスキャナに 24

個ついています（足りなくなりましたら購入も可能です。お問い合わせください）。 

 

2．スライドホルダをスキャナのカローセル（SureScan の場合はカセット）にセットします。複数のスライドグラ

スをスキャンする場合は、隣り合うスロットにセットしてください。また、H と書かれている Home スロット

にはセットしないでください。SureScan の場合は、どの位置にセットしても構いません。 

 

また、どちらのタイプのスキャナでもスライドホルダのカバーはきちんと閉めて下さい。完全に閉まってい

ない状態でスキャンを開始すると、スキャナ内でスライドホルダが引っかかってしまい、エンジニアによる

修理が必要となることがあります。 

 

2. スライドのスキャン 

スキャナコントロールソフト ver.7（B バージョンスキャナ）をお使いの場合 

(8x15K, 4x44K,2x105K, 1x244K フォーマットのスキャン) 

 1. 画面下の“Scanner status”が『Scanner ready』になっていることを確認します。 

 2. スライドを入れたスロット番号を、“Start slot”と“End slot”で指定します。 

 3. 設定を変更するスライドをテーブル内で選択してください(複数枚選択できます)。選択されると青くハイ

ライトされます。 

 4. “eXtended Dynamic Range Scan Mode”にチェックを入れ“Hi”を 100%に、“Lo”を 10%にします。 

 5. “Edit Slot Values>>”をクリックしてメイン画面を拡張します。 

 

(次項につづく) 

 

  

① 

② 

③ 

④ 

⑤ 

レ 
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6. 拡張された画面で、下の表に従って各種設定変更を行います。 

注意 Scan resolution が 5 ミクロンになっていることを必ず確認してください。 

 

 

 

 

 

 

 

 

 

7. “Output path”で、スキャン画像を出力したいフォルダを指定します。 

8.  設定が終了したら、“Set Values”をクリックします（Set Values をクリックしないと変更が反映されませ

ん）。テーブル内の設定値が変更されたことを確認してください。 

9. スキャン設定が確認できたら、“Scan Slot n-m”をクリックするとスキャンが開始します。 

10. スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

11. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

【参考】 XDR スキャン 

※ eXtended Dynamic range：XDR スキャンは、１枚のスライドグラスを、異なった PMT（4x44K フォーマッ

トの場合、高 PMT：XDR Hi 100％、低 PMT：XDR Lo 10％）に変え、自動的に連続スキャンする機能で

す。Feature Extraction 9.1 以降はこの 2 つのスキャンを自動的に１つにまとめ、広いダイナミックレンジ

が得られる結果を自動的に出力することが可能です。  

⑦ 

⑨ 

⑧ ⑥ 

5 Red&Green 
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≪スキャンのデフォルト設定変更法≫ 

1. スキャナコントロールソフトを立ち上げ、ツールバーの Settings > Modify Default Settings を選

択します。 

2. 表示された Default Setting ボックス内で、変更したい項目を変更し、OK をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

スキャナコントロールソフト ver.8（C バージョンスキャナ）をお使いの場合 

(8x60K, 4x180K, 2x400K, 1x1M, 8x15K, 4x44K, 2x105K, 1x244K フォーマットのスキャン) 

 

1. 画面下の“Scanner status”が『Scanner ready』になっていることを確認します。 

2. スライドを入れたスロット番号を、“Start slot”と“End slot”で指定します。 

 

 

 

 

 

 

 

 

 

 

 

（次項につづく） 

  

① 

② ③ 

⑤ 

④ 
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3. “Profile”リストから、既存のプロファイルを選択します。 

 <default> プログラムインストール後に現れるデフォルト設定 

AgilentHD_GX_1Color 遺伝子発現アレイ 1 カラー(8x15K, 4x44K, 2x105K, 1x244K) 

AgilentG3_GX_1Color 遺伝子発現アレイ 1 カラー(8x60K, 4x180K, 2x400K, 1x1M) 

AgilentHD_GX_2Color 遺伝子発現アレイ 2 カラー(8x15K, 4x44K, 2x105K, 1x244K) 

AgilentG3_GX_2Color 遺伝子発現アレイ 2 カラー(8x60K, 4x180K, 2x400K, 1x1M) 

AgilentHD_CGH   CGH/ChIP マイクロアレイ(8x15K, 4x44K, 2x105K, 1x244K) 

AgielntG3_CGH   CGH/ChIP マイクロアレイ(8x60K, 4x180K, 2x400K, 1x1M) 

AgilentHD_miRNA  miRNA マイクロアレイ 

 

選択肢に適切なプロファイルがない場合は、ウェブからダウンロードしコントロールソフトにインポートす

るか、上記プロファイルのいずれかを選択後各項目を個別に変更してください。 

 

【プロファイルの入手およびインポート】 

1．下記サイトからAgilentG3_GX_Profiles.zip をダウンロードし、PCに保存します（スキャナに付属の

PC ではなくて結構です）。 

https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Cust

om&PageID=2074  

2．ダウンロードしたファイルを右クリック＞Open with(プログラムから開く)＞Compressed zipped 

folders あるいは Winzip と選択し、解凍します。  

3．解凍したファイル(AgilentG3_GX_Profiles.pfl）をスキャナに付属の PC にコピーしてください。  

4．コントロールソフトの Tool> Profile Editor…と選択します。  

5．現れた Profile Editor 画面で Import をクリックし、保存した解凍ファイル(AgilentG3_GX_Profiles.pfl）

を指定します。 

 

6． Yes をクリックし、 Profile Editor 画面の Close をクリックします。  

  

https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Custom&PageID=2074
https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Custom&PageID=2074
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4. 選択したプロファイルの項目で、個別に変更する必要があればプルダウンで変更します。 

変更できる項目（太字が defalt です） 

 1). Dye Channel: Red（1 カラー(Cy5)） 

Green(1 カラー（Cy3）), 

Red+Green（2 カラー） 

 

 2). Scan Region: Full Slide 

 Agilent HD (アジレントアレイ) 

 

3). Scan Resolution: 2um, 3um, 5um, 10um,  

double path (2um, 3um, 5um) 

※ C バージョンのスキャナでも 2um および 3um が 

選択肢にない場合は高密度タイプのマイクロアレイ 

(8x60K, 4x180K, 2x400K, 1x1M)に対応していません。 

 

4). TIFF file dynamic range: 20bit, 16bit  

 

 

5). R/G PMT gain: 100% ～ 1% 

 

6). XDR ratio: 0.5, 0.33, 0.2, 0.1, 0.05, 

 NoXDR 

7). Output Path: 

※ 変更した設定は Profile に保存することができます。 [Profile>Save as] 

 

5. スキャン設定が確認できたら、“Scan Slot n-m”をクリックするとスキャンが開始します。 

6. スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

 スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

7. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

 

【参考】 16bit スキャンと 20bit スキャン 

※ TIFF ファイルに保存されるシグナル強度範囲を指定します。 

20bit スキャンは、1 回のスキャンで 5 桁のダイナミックレンジでシグナル強度を保存できます。XDR スキャ

ンは不要なため、20bit スキャンを選択すると XDR 機能はオフになります。 

16bitスキャンは、1回のスキャンでは遺伝子発現のダイナミックレンジをカバーしきれないため、XDR機能

を使って 2 回の PMT gain の異なる連続スキャンを行ない、その結果を統合して使います。この場合、XDR 

ratio を指定する必要があります。遺伝子発現のデフォルトの XDR ratio は 0.1 です。 

20bit で 1 回スキャンしたデータと 16bit で XDR スキャンをしたデータは、結果にほぼ違いはありません。 

  



遺伝子発現マイクロアレイ 2 色法プロトコル 51 

スキャナコントロールソフト ver.9.1（SureScan マイクロアレイスキャナ）をお使いの場合 

注意 ドアを手で開けないてください。エラーが発生します。 

カセットを手で動かさないでください。エラーが発生します。 

エラーが発生したら、スキャナコントロールソフトウェアを再起動する必要があります。 

 

1. 起動すると次の画面になります。 

 

 

 

 

2. 初期化が終了すると、ファンクションボタンのOpen Doorボタンがアクティブになります。クリックし、カセ

ットにスライドをセットします。スライドがセットされているカセットは青色で表示されます。また、各パラメ

ータの編集ができるようになります。 

 

  

スライドがセットさ

れると青色で表示

されます。 
プロトコルファイルを選択

します。 
データの保存先を指定します。 

メニューバー 

スロットステータス

インジケータ 

ファンクションボタン 

セッティングペイン 

ステータスバー 

スロットテーブル 

ログ 
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3. Scan Protocolから適切なプロトコルファイルを選択します。AgilentG3_HiSen_GX_1Colorまたは

AgilentG3_HiSen_GX_2Color（1x1M、2x400K、4x180K、8x60Kの場合）あるいは、

AgilentHD_HiSen_GX_1ColorまたはAgilentHD_HiSen_GX_2Color（1x244K、2x105K、4x44K、

8x15Kの場合）を選択します。 

ウィンドウ右側のセッティングペインでスキャン設定を確認してください。プルダウンに

AgilentHD_HiSen_GX_1ColorまたはAgilentHD_HiSen_GX_2Colorがない場合や、設定を変更す

る必要があれば、ウィンドウ右側のセッティングペインで個別にプルダウンメニューで変更できます。

AgilentHD_GX_1ColorまたはAgilentHD_GX_2Colorを選択した場合はResolutionを”5 um”から”5 

um high sensitivity”に変更してください。この設定をScan Protocolとして保存する場合は下記をご参

照ください。 

 

 

4. 必要があればデータの保存先を変更します。※D drive内のフォルダを指定してください。 

 

 

 

5. ファンクションボタンのAll to Queueボタンをクリックし、ステータスバーでScannerのステータスが

Readyであることを確認します。 

6. ファンクションボタンのStart Scanボタンをクリックするとスキャンを開始します。 

7. スキャンが終了し、Open Doorボタンがアクティブになったら、クリックします。 

8. スライドホルダを取り出します。 

9. コントロールソフトを閉じた後にスキャナおよびPCの電源を消してください。 

 

 

≪変更したプロトコルをScan Protocolとして保存する場合≫ 

1. メニューバーの Tools から「Scan Protocol Editor…」を選択します。  

2. AgilentHD_GX_1Color または AgilentHD_GX_2Color を選択し Scan Protocol Editor 画面下部の

「Save As」をクリックし、「Save As New Name」ボックスで、今から設定する新しい Protocol Editor に

分かりやすい名前（例：AgilentHD_HiSens_GX_1color）をつけて保存します。  

3. 設定した新しい名前の Protocol が選択されているのを確認した後、Resolution という項目のプルダウ

ンメニューを展開し、”5 um”から”5 um high sensitivity”に変更してください。 
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4. Resolution が間違いなく High Sensitivity に設定されており、その他の項目に変更が加えられていな

いことを確認した後、ボックス下部の Save をクリックします。  

今後のスキャン時には、この新規作成した Protocol を Scan Protocol として選択するだけで、高感度

設定でスキャンをすることが出来ます。  
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11. ハイブリダイゼーション後のマイクロアレイの画像化 

ここでは、Feature Extraction ソフトウェアによるイメージの簡単な確認法をご紹介します。より詳細につ

いては、Feature Extraction 英語版マニュアルをご覧ください。 

Feature Extraction Ver.8 以降の画面は、Project Work Window（スポットの数値化の画面）と Image 

Work Window（イメージ確認の画面）があります。 

 

① Feature Extraction ソフトウェアの起動 

以下のいずれかの方法で、Image Work Window を開き、TIFF イメージを確認します。 

⚫ tif イメージファイルをデスクトップの Feature Extraction ショートカット  にドラッグ＆ドロップ 

⚫ Feature Extraction ショートカット     をダブルクリックしてソフトを起動後、メニューバーの 

【File>Open > Image】で開きたいファイルを指定 

 

② バックグランドのむらの確認 

ログスケール表示によりバックグランドのむらを確認します。 

 

 

 

 

 

 

 

 

 

ログスケール 

リニアスケール 

切り替えボタン 
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③ イメージデータのスケールの確認 

両チャンネルのデータレンジを確認します。 

注意 ここでの確認はイメージデータ全体に対するものとなります（スポット以外のエリアも含みます）。 

スポットレベルで確認する（例：コントロールスポットを除く全遺伝子スポットに対してデータスケールを確認

する）ためには、スポット定量が必要になりますので御注意ください。 

 

 

③―１：カラーレンジの設定 

をクリック 

イメージデータ全体に対し、１％から 99％の設定 

（デフォルト）における最大値・最小値を確認します。 

 

 

 

 

 

③―２：ヒストグラムの作成 

 をクリック 

Cropping Mode を Off にします。 

 

アレイの左上隅で右クリックし、 

そのままポインタをアレイの右下

隅までドラッグさせます。 

 

上述のカラーレンジの設定と併

せて、両チャンネルの分布が極

端に異ならないか確認します。 

 

 

 

 

 

④  クロップモードの ON/OFF 

クロップモードが ON の場合、ポインタの横にひし形のマークが表示されます。イメージをクロップする

と新しいウィンドウで切り取った画像が表示されます。OFF の場合、クロップ時にその大きさに合わせ

てウィンドウが拡大表示されます。 

 

をクリックすることで ON/OFF の切り替えができます。 
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⑤ カラースワップの確認 

色素交換を行ったアレイがある場合、２枚のアレイイメージを比べて大まかなスワップ傾向が見られるかを

調べます。 

 

 

 

 

 

 

 

 

 

 

 

この傾向を適正に見る為に、カラーレンジの設定を１％から９９％ 

の設定（デフォルト）にしてください。 

設定に応じて、Cy3 の発現量が多い場合に緑色、Cy5 の発現が

多い場合に赤色になるように表示されます。 

 

 

⑥ ラインプロット 

スポットの形状を確認します。 

 

 

 

 

 

 

 

 

 

 

 

 

ラインプロットを見たい領域の左上隅で左クリックし、そのままポインタを領域の右下隅までドラッグさせます。

次に、ラインプロットを見たい位置（上の図の場合、青線上のどこでも構いません）にポインタを合わせてダ

ブル左クリックします。 

このように、Feature Extraction する前に、ヒストグラムやラインプロットを使ってデータ抽出の妨げの可能

性となる異常スポットやバックグランドの確認をすることができます。 
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12. Feature Extraction ソフトウェアで数値化を行う前に 

① Project Work Window を開く 

以下のいずれかの方法で、Project Work Window（スポットの数値化の画面）を開き、必要なファイ

ルがあるかどうかを確認します。 

 

⚫ メニューバーの【File > New > Standard Project】を選択 

⚫ Feature Extraction ショートカット     をダブルクリック 

 

 

Project 

Explorer 

Pane 

Project Work Window 

Grid Template Browser 

FE Protocol Browser 

QC Metric Set Browser 
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② 必要なファイルの確認 

Grid Template Browser： インストール済みのデザインファイルまたは Grid File のリスト表示。ここに

これから数値化するマイクロアレイの種類に対応したデザインファイルが

あるか確認する。 

 確認方法：(1) マイクロアレイのデザイン ID を確認する 

デザイン ID …アレイスライドのラベルに印字されている、または TIFF ファイルのファイル

名に記載の 25 から始まる 12 桁の番号の、25 に続く 5 ケタの番号に 0 を

付けた 6 桁の番号(252800410025 であれば 028004 がデザイン ID) 

(2) Grid Template Browser に目的のデザイン番号のファイルがあるかを確認する。 

（028004_D_F_20110524 等） 

➢ 必要なデザインファイルがなければ、eArray からダウンロードする(巻末の Appendix3 参照)。 

デザインファイルは、各プローブのマイクロアレイ上の位置情報と、対応する遺伝子の情報を含んだファイ

ルです。ファイル名の末尾の日付はファイルの更新日付で、更新されると遺伝子の Annotation 情報は変

更されることがあります。より新しい情報でデータ解析をしたい場合、既にデザインファイルが存在しても、

eArray からダウンロードした最新のデザインファイルをお使い下さい。(GeneSpring で解析をする場合、

Annotation 情報はデザインファイルの情報に依存しないため、更新日付は古くても問題ありません) 

 

FE Protocol Browser： 各数値化ステップのアルゴリズムのパラメータを含む、アプリケー ションごと

のファイル。ダブルクリックで開いて変更・保存可能。 

FE プロトコル例） GE1_107_Sep09 

GE1 … 遺伝子発現 1 カラーアレイ用 

GE2 … 遺伝子発現 2 カラーアレイ用 

CGH … アレイ CGH 用 

ChIP … ChIP-on-chip 用 

miRNA … miRNA アレイ用 

107 … このプロトコルファイルが対応している Feature Extraction のバージョン 

（お使いのソフトウェアのバージョンに合った FE プロトコルを使って下さい） 

Sep09 … ファイルの更新時期（より新しいものを使って下さい） 

NonAT … アジレント製以外のアレイデータを数値化する時に必要。 

➢ 必要な FE プロトコルファイルがなければ、ダウンロードする(巻末の Appendix4 参照)。 

 

QC Metric Set Browser： 各アプリケーションでのQCメトリック（実験の成否判断の閾値）のセット。

Feature Extraction10 以降で数値化すると、いくつかの実測値が、アプ

リケーションごとに設定 された閾値の範囲内かどうかを QCレポートに自

動出力されます。 

➢ 必要なメトリックセットファイルがなければ、下記 Web Site からダウンロードことが可能です。 

 http://www.genomics.agilent.com/article.jsp?pageId=2041 

http://www.genomics.agilent.com/article.jsp?pageId=2041
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③必要なファイルのインポート 

■ Grid Template Browser 内に新規デザインファイルを加える場合 

（この操作は Feature Extraction に必要なデザインファイルがない場合、もしくはより新しいデザインファイ

ルで数値化したい時のみ必要になります） 

(1) eArray から必要なデザインファイルをダウンロードする(巻末の Appendix3 参照)。 

(2) ダウンロードしたデザインファイルを解凍し、XML ファイルを“日本語が入らないパス”のフォ   

ルダに保存する。 

※ 圧縮ファイルを解凍する際は、Winzip あるいは Windows XP 以降に付属のソフト（解凍するファイル

上で右クリック＞Open with（プログラムから開く）＞Compressed(zipped)Folders(XP) または

Explorer(Windous7)) を選択）を使用してください。 

(3) Grid Template Browser Pane 上で右クリック→Add…を選択後、目的のデザインファイ  

ルを選択。（または、メニューバー【Tools > Grid Template > Add…】を選択後、目的のデザ  

インファイルを選択） 

 

■ FE Protocol Browser 内に新規 Protocol を加える場合  

（この操作は Feature Extraction に必要な FE プロトコルがない場合のみ必要になります） 

FE Protocol Browser Pane 上で右クリック → Import…を選択後、目的の Protocol を選択して下さい。 

（または、メニューバー【Tools > FE Protocol > Import…】を選択後、目的の Protocol を選択） 

 

■ インポートしたデザインファイルに、適切な FE プロトコルを設定する方法 

（この操作は新しいデザインファイルをインポートした時のみ必要になります。必要な FE プロトコルが数値

化時に毎回自動で割り当てられるようになるため便利です） 

(1) Grid Template Browser Pane に格納されている目的のデザインファイルを選択する。 

(2) ダブルクリック（または、メニューバー【Tools > Grid Template > Properties】を選択）して、 

FE Grid Template Properties（右図）の window を開く。 

(3) Default Protocol（2 カラーデータ用）、 

 Default One Color Protocol に適切な Protocol を 

指定します。 
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13. Feature Extraction ソフトウェアによる数値化 

STEP1. Feature Extraction ソフトウェアの起動 

以下のいずれかの方法でProject Work Windowを立ち上げて、スポット数値化を行います。 

⚫ デスクトップのFeature Extractionショートカット  をダブルクリック 

⚫ 【Start>Programs>Agilent >Feature Extraction】 からソフトウェアを開始 

 

STEP2. FE projectへ数値化するイメージ(.tif)を追加 

ツールバーにあるAdd New Extraction Set(s)のアイコ ン をクリックします。あるいは、Project 

Explorer内で、右クリックをし、Add Extraction…を選択します。 

 

1. tif.ファイルを選択して、Openをクリックします。複数のファイルを指定するときには、ShiftまたはCtrlキーを

押しながら選択します。 

※ XDR設定でスキャンしたtif画像は、2種類（HおよびL)のScan Fileがイメージファイルとして認識されま

す。その際、HおよびLのScan Fileが、同一フォルダ内に存在する必要があります。 

 

2. Project Explorer内のProject下の階層にExtraction Setが、さらにExtraction Set下の階層にImage File、

Grid File、Protocolが現われることを確認して下さい。空欄の項目がある場合、適切なGrid Templateと

Protocolを選択してください（次頁参照）。 

 

Project ： Feature Extraction の Run 設定全体をまとめた情報です。 

1 つ以上の Extraction Set から構成されています。 

Extraction Set ： 解析する tif 画像ごとに作成されます。 

Image File、Grid Template (Grid File)、Protocol から構成されています。 

Image File ： 解析対象のマイクロアレイ画像のことです。 

Grid Template (Grid File) ： Grid 情報です。Agilent アレイの場合はデザインファイルを意味します。 

Protocol ：イメージの数値化の際、適用する解析アルゴリズムの設定です。 

 

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project
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STEP3. 数値化設定の確認とProjectの設定 

１.数値化設定の確認をします。 

⚫ Project Work Window中央のExtraction Set Configurationタブシートを選択。 

 

⚫ Extraction Setで用いる構成（TIFFイメージ、デザインファイル、Protocol）を確認します。 

空欄になっている場合、プルダウンから選択することができます。またプルダウン内にも必要なファイ

ルが表れない場合、p.55を参照の上必要なファイルをインポートして下さい。 

 

 

2. Projectの設定、出力ファイルの設定を行います。 

⚫ Project Propertiesタブシートを選択する 

あるいは、Project Explorer内の解析に用いる 

Projectをダブルクリック。 

⚫ Projectの設定を確認、変更をします 

（解析結果ファイルのOutputフォルダの設定、 

結果としてOutputするファイル種類の設定など）。 

 

 

 

（ソフトウェアのデフォルト設定を変更したい場合は、メニューバー【Tools > Preference】で設定画面を開き、

【FE Project> Output & Data Transfer】を選択して下さい）
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(1) 出力方法の設定 

出力方法は以下の4つから選択することができます。 

None （出力しない） 

Local file only （ハードディスクに出力する） 

FTP send only （外部にファイルを転送する） 

Both local file and FTP send （両方に出力する） 

デフォルトでは、TEXT、Visual Results、QC Reportの結果が出力されるよう、これらの項目の設定が

Local file only、それ以外の項目（MAGE、JPEG、Grid）は、Noneが選択されています。 

 

(2) 出力ファイルの設定 

MAGE アレイの結果をXML形式で出力。解析にロゼッタ社のリゾルバー/ルミネーターを使用す 

る場合、Array Expressにデータを転送する場合などに必要。 

JPEG 各アレイ画像をJPEG形式で出力。この画像ファイルからは数値化はできないので注意。 

TEXT  アレイの結果をタブ区切りテキスト形式で出力。解析にGeneSpring、エクセルなどを使用す

る場合に必要。 

※ TEXTファイルのOutput設定は、以下のOutput Package設定が可能です。 

Full ： 数値化項目全ての結果を出力します。 

Compact ： 数値化項目の一部（通常、データ解析に用いると考えられる項目）の結果

を出力します。Fullに比べ、約1/3のファイルサイズとなります。 

GeneSpring, DNA Analyticsを使用する場合はCompact推奨。 

Visual Results 数値化結果のTIFF画像へ重ね描きするのに必要な.shpファイルを出力。 

Grid グリッド合わせの詳細（スポット位置情報など）をCSV形式で出力。 

QC report 実験の成否をチェックするための項目を含んだレポートを出力。 

※ QC reportはPDFファイルあるいはHTMLファイルで出力できます。 

PDFファイルは”Local PDF file only”を、HTMLファイルは””Local HTML file only”を選

択してください。HTMLファイルの場合は数値化後、必ずQCReport_Graphsというフォ

ルダと同じフォルダにHTMLファイルを保存してください。 

 

(3) QCメトリックの設定（ver.10.7より前のバージョンをお使いの場合） 

Project Propertiesタブシート一番下部“Other”の“QC metric set”プルダウンから“GE2_QCMT_Jan09”

を選択します。 

プルダウンに“GE2_QCMT_Jan09”が表示されない場合、下記Web Siteからファイルをダウンロードし、

QC Metric Set Browser上で右クリックしてファイルを追加して下さい。

http://www.genomics.agilent.com/article.jsp?pageId=2041 

3. 設定を確認したら、Projectの保存を行います。 

⚫ メニューバー【File > Save As】を選択し、FE Project Data Files (.fep)ファイルを保存するための適切な

フォルダを選択もしくは作成して下さい。 

⚫ フォルダ指定後、Projectに名前を付けて保存して下さい。 

http://www.genomics.agilent.com/article.jsp?pageId=2041
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Running MonitorRunning Monitor

Project 終了後Project 終了後

STEP4. Feature Extraction Project をスタート (数値化の実行) 

メニューバー【Project > Start Extracting】またはProject Run Mode On/Offボタン を選択すると、

Projectがスタートします。スタート後、Summary ReportタブとRunning Monitorが現われます。 

 

 

 

 

進行状況は、Running Monitorに表示されます。Project終了後、Summary Reportタブを選択していると、

Project Work Windowに、Project終了を示すSummaryが現われます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※ 4x44K及び4x180K フォーマットの出力結果は、ファイル名末尾 “…_1” ～ “…_4” の4つのデータが得ら

れます。8x15K及び8x60K フォーマットの出力結果は、ファイル名末尾 “…_1_1” ～ “…2_4” の8つのデ

ータが得られます。 

それぞれ、下図の位置のアレイに対応しています(バーコードラベルを左側、Inactiveサイドが手前の状態)。 

 

 

 

 

 

  

1 2 3 41 2 3 4
1_1 1_2 1_3 1_4

2_1 2_2 2_3 2_4

1_1 1_2 1_3 1_41_1 1_2 1_3 1_4

2_1 2_2 2_3 2_42_1 2_2 2_3 2_4
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Step 5—QC Reportの確認 

1. 出力された結果ファイルに、“pdf形式のQCReportファイル”があることを確認して下さい。 

2. “pdf形式のQCReportファイル”を開いて下さい。QC Reportを確認することができます。 

 

QC Reportは、以下の項目を示します。 

（各項目の詳細は、Help > Reference Guide で確認することができます。） 
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出 力 さ れ た

QC metrics

のテーブル 
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Step 6―Visual Resultの確認 

Step3で選択したVisual Resultファイルを使ってフラグ等の確認をします。 

1. Feature Extraction内に、画像を表示させます。XDRスキャンをした場合は、1stの画像（ファイル名の末尾に

_Hが付いた画像）を表示させます。 

2. メニューバーのFeature Extraction > Load Visual Resultを選択します。 

3. 該当するVisual Resultファイル（.shp）を選択します。このとき表示させている画像に対応するファイルを選択

してください。 

4. 画像にVisual Resultが重ね描きされます。 

5. クロップモードやズームイン機能、ログスケール表示機能を使って表示を調節します。 

 

 

 

 

 

 

 

 

View outliers onlyにチェックが入っている状態 

 

 

 

 

 

 

 

 

 

6. View > Extraction Results からVisual Resultsの表示法を選択できます。 

 

Help > Feature Extraction Output Quick Referenceで各リングの色が示すアウトライヤーを確認できます。 
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Step7. テキストファイルの確認 

以下の表は、Compact 設定で出力されたテキストファイルの主な項目です。 

通常データ解析では gProcessedSignal および rProcessedSignal をシグナル値、両シグナル値の比を

ratio、ProbeName を ID として使用します。 

これらの項目は数値化テキストファイルをエクセルで開くと、10 行目に表示されます。GeneSpring GX

をご使用の際は、出力ファイルの内容は変更せず、出力テキストファイルをそのまま GeneSpring に認

識させてください。 

 

 

項目(Green) 項目(Red) 内容 

 

FeatureNum フィーチャ番号 

ControlType フィーチャのコントロールタイプ 

 ネガティブおよびポジティブコントロール

は数値化の際に Feature Extraction が

各種補正係数などを計算する際に使用

します。生物学的な解析には必要ありま

せん。 

コントロールプローブ以外のプローブ 

-1 ネガティブコントロール 

1 ポジティブコントロール 

ProbeName 各 60mer の配列に対応した Probe ID 

SystematicName 各プローブがターゲットとしている配列の

ID。可能な限り公的なデータベースの ID

を使用 

gProcessedSignal rProcessedSignal 全ての数値化プロセスを経たシグナル 

強度。1 色法の場合は、Surrogate 後の 

値、2 色法の場合は色素補正後の値。 

gBGSubsignal rBGSubsignal バックグランド補正を行った後、各種補正を行う前のシグ

ナル強度。



遺伝子発現マイクロアレイ 2 色法プロトコル 68 

Feature Extraction 由来のフラグ 

 

 

項目(Green) 項目(Red) 内容 

 

gIsSaturated rIsSaturated 0 サチュレーションしていないフィーチャ 

1 サチュレーションしているフィーチャ 

gIsFeatNonUnifOL rIsFeatNonUnifOL 各フィーチャ内のシグナルの均一性を検証 

0 フラグが立っていないフィーチャ 

1 フラグが立った不均一なフィーチャ 

gIsFeatPopnOL rIsFeatPopnOL アレイ内に繰り返し搭載されている同じ配列

を持つプローブシグナルの均一性を検証。1

回しか搭載されていないプローブは対象外。 

0 フラグが立っていないフィーチャ 

1 フラグが立ったフィーチャ 

gIsPosAndSignif rIsPosAndSignif フィーチャのシグナルがバックグランドと有意

に差があるかを判定。判定法は両側 t 検定。 

0 バックグランドと差がないフィーチャ 

1 バックグランドと差があるフィーチャ 

gIsWellAboveBG rIsWellAboveBG フィーチャのシグナルがバックグランドと有意

に差があるかを判定。BGSubsignalの値が、

バックグランドの標準偏差（エラーモデルから

算出）を各アレイフォーマットの最適値倍 （デ

フォルトは13倍）した値よりも大きいかどうか

で判定。PosAndSignifよりも厳しい判定法。 

0 バックグランドと差がないフィーチャ 

1 バックグランドと差があるフィーチャ 

  



遺伝子発現マイクロアレイ 2 色法プロトコル 69 

スポット数値化と解析 

DNA マイクロアレイの解析には 2 種類のソフトウェアを使用します。 

 

まずスキャンで得た TIFF イメージからスポットの数値化を行うソフトウェアが必要になります。ここでは

スポットのシグナル強度、ローカルバックグランドのシグナル強度などが算出されます。Agilent スキャ

ナに付属する Feature Extraction はこれに加えてバックグランドの引き算、色素補正を行い、最終的

な 2 サンプルの発現比（LogRatio）および統計処理されたエラー値と P 値を決定します。 

 

上記のスポット解析を行った数値データを用いて、高度なデータ解析を別のソフトウェアで行います。

一番身近なものではエクセルが挙げられますが、エクセルはアレイごとの結果を解析するのには適し

ていますが、複数アレイの結果の比較(クラスター解析など)には適していません。データ解析を行うソ

フトウェアは数多く製品化されていますが、本トレーニングではエクセルで数値化のアウトプットデータ

を理解した上で、GeneSpring GX を使ったデモを行い、さらに生物学的意義を付け加えていきます。 

 

 

                           Feature Extraction など      GeneSpring GX など 

図:スポット解析、データ解析の流れ 

 

 

スポットの数値化は以下の手順で行われます。 

① スポットの中心位置の決定 

② スポット（Feature）およびバックグラウンド領域の決定 

③ スポット（Feature）のシグナル強度計算 

④ バックグランドのシグナル強度計算 

⑤ バックグランド補正 

⑥ Multiplicative Detrending 

⑦ 色素補正 

⑧ 発現差計算 
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Feature Extraction の結果解析 

サンプル間の発現差を求めるもっとも単純な方法は、Cyanine3 と Cyanine5 の色素強度の比

(FoldChange)になりますが、この方法では以下の図に示したように、Up と Down のスケールが非対

称になってしまいます。コンピュータを用いたデータ解析を進めるためには適切ではありません。 

 

 

 

そこで一般的に、Up と Down が対称なスケールになるように、色素強度比の対数(LogRatio)が計算

されています。 

 

 

フィーチャエクストラクションでは、LogRatio として底が 10 の対数(log10)が用いられています。 

 

 

 

 

 

 

  

 

Cy3

Cy5

Cy3

Cy5
分数

10 2 3… ∞

UpDown

10 2 3… ∞

UpDown

Ratio:　UpとDown非対称なスケール

LogRatio : log10

Cyanine3色素強度

Cyanine5色素強度
LogRatio : log10

Cyanine3色素強度

Cyanine5色素強度

Log Ratio:UpとDown対称なスケール

0-2 -1

UpDown

1 2

Log Ratio:UpとDown対称なスケール

0-2 -1

UpDown

1 20-2 -1

UpDown

1 2
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Appendix1：total RNA の品質チェック 

Step1．UV-Vis による Total RNA の評価 

本プロトコルでは、測定に用いるサンプル量を抑えるため、NanoDrop の使用をお勧めいたします。 

NanoDrop を使用する場合は、メニュー画面で Nucleic Acid Measurement をクリックし、Sample Type は

RNA-40 を選択します。 

⚫ 少なくとも、以下の 4 つの波長における吸光度を測定して下さい。 

A230  グアニジンイソチオシアネートや塩類・糖類、その他有機溶媒などの混入を検出します 

A260  total RNA の濃度を測定します 

A280  タンパク質・フェノールの混入を検出します 

A320  異常な吸収がないかをチェックします 

⚫ 以下の基準を満たしているかをチェックして下さい。 

A260/A280＝1.8～2.0 A260/A230>2.0 

この基準を満たしていない場合、タンパク質や有機溶媒の混入が疑われ、ラベル化反応がうまくいか

ないことが予想されます。また、RNA を正確に定量できていない可能性もあります。抽出をやり直すか、

混入物を除去するための追加の精製を行って下さい。 

 

⚫ UV スペクトルを採取し、スペクトルパターンを記録して下さい。 

純度の高い核酸のスペクトルは、230nm に谷、260nm に吸収極大があり、長波長側の吸光度は 0 で

安定しています。 

 

Step2．Agilent 2100 Bioanalyzer による total RNA の評価 

UV-Vis の測定結果からは RNA がどのぐらい分解しているかを知ることはできません。必ず電気泳動で

RNA が分解していないか、確認してください。本プロトコルでは、Agilent 2100 Bioanalyzer を推奨していま

す。Agilent 2100 Bioanalyzer を用いる場合は、サンプルの濃度に応じて、RNA6000 Nano kit あるいは

Pico kit を使用してください。実際の操作は各キットの説明書に従ってください。 

 

電気泳動の結果から下記 3 点を確認し、分解していないか評価してください。 

⚫ 18S および 28S リボソーマル RNA（あるいは生物種特有の rRNA）の明確なピークが確認できる 

⚫ 18S および 28S リボソーマル RNA のピーク間に分解物がない 

⚫ 18S リボソーマル RNA ピークと Lower Maker 間に分解物がない 

（5S リボソーマル RNA は精製法によって高さが変わります。カラムを用いて total RNA を精製した場

合、通常低くなります。） 

Agilent 2100 Expert Software は、total RNA の品質の指標として RNA Integrity Number（RIN）を自動

で算出します。RIN を使うと、RNA の分解具合などの質の標準化が容易になります。 

RIN や Bioanalyzer に 関 す る よ り 詳 細 な 情 報 は 、 以 下 の ウ ェ ブ サ イ ト よ り 、 “ RNA integrity 

number(RIN)-Standardization of RNA quality control” (part number 5989-1165EN)をご覧下さい。

www.agilent.com/chem/labonachip 

http://www.agilent.com/chem/labonachip
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下の図では、分解具合の異なる 3 種類の total RNA を分析した結果のエレクトロフェログラムを示していま

す。お客様が、品質の悪いTotal RNA による実験結果の偏りを排除するために、RIN の各々の閾値を実験

系ごとに決定することが重要となります。 

 

 

状態の異なる（ヒト）Total RNA を Eukaryote total RNA Nano assay によって分析した結果 

赤…RIN 8.1 青…RIN 5.9 緑…RIN 3.6 
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Appendix2：サーマルサイクラーを用いた実験プロトコル 

ウォーターバスの数に限りがある場合、PCR チューブ及びサーマルサイクラーを用いて実験をすることも可能で

す。ただし、1.5 mL チューブを使用した場合と比べると、cRNA の収量は少し下がる傾向があります 

 

Step1.サーマルサイクラーのプログラム設定 

下記のようにプログラムを設定します。 

プログラム 1：65℃ 10 分、4℃ hold 

プログラム 2：40℃ 2 時間、70℃ 15 分、4℃ hold 

プログラム 3：40℃ 2 時間、4℃ hold 

4℃のステップは 5 分で十分です。次のステップの準備が整っていない場合は、4℃に置いてください。 

Heat Lid の設定にしてください。 

 

Step2.totalRNA からの cDNA 合成  

1．25ng から 200ng の totalRNA を PCR チューブあるいは 96 穴 PCR プレートに加えます。最低 25ng

の totalRNA を用いてください。 

2．2uL の希釈した 2 カラー用 Spike-Mix を加えます。Spike-Mix の希釈手順には、p.17 をご覧ください。 

3．p.18 の表に従い、T7 Promoter Primer Mix を調製します。 

4．1.8uL の T7 Promoter Primer Mix を各チューブに加え、よく混ぜます。総量は 5.3uL になります。 

5．サーマルサイクラーにPCRチューブあるいは96穴PCRプレートをセットします。プログラム1を走らせ、

熱変性を行います。 

6．65℃ 10 分の過程が終了したら、氷上に移します。 

7．p.19 の表に従い、cDNA Master Mix を調製します。 

8．4.7uL の cDNA Master Mix を各サンプルに加え、ピペッティングで良く混合します。総量は 10uL になり

ます。 

9．サーマルサイクラーにPCRチューブあるいは96穴PCRプレートをセットします。プログラム2を走らせ、

cDNA 合成反応をスタートします。 

 

Step3.ラベル化 cRNA の合成 

1．1.5mL のチューブに、p.20 の表に従い Transcription Master Mix を調製します。使用直前に T7 RNA 

Polymerase Blend をマスターミックスに加えます。ピペッティングで良く混合します。 

2．サンプルはマスターミックスを添加するまで、サーマルサイクラー中で 4℃、あるいは氷上に置きます。 

3．各サンプルに、6uL の Transcription Master Mix を加え、ピペッティングで良く混ぜます。 

4．サーマルサイクラーにPCRチューブあるいは96穴PCRプレートをセットします。プログラム3を走らせ、

cRNA 合成反応をスタートします。 

5．p.22 に従い、ラベル化 cRNA を精製します。その後の操作は、1.5mL チューブでラベル化を行った場合

と同じです。  
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Appendix3：詳細なスキャナの起動手順 

 

B スキャナまたは C スキャナをお使いの場合 

1. PC の電源を入れログインします。 

2. PC が完全に立ち上がってからスキャナの電源を入れます。 

3. スキャナ前面の LED が緑とオレンジに点灯している（点滅ではありません）ことを確認します。電源を入

れてから数分かかります。 

4. スキャンコントロールソフトを立ち上げます。スキャナと PC の通信が始まってから、レーザーが安定す

るまで 20 分ほどかかります。 

 

SureScan をお使いの場合 

1. PC の電源を入れログインし、スキャナの電源を入れます。 

2. スキャナ前面右上にある LED がオレンジ→白色の順に光り、しばらくすると消灯します。LED が消灯す

るまで待ちます。（電源を入れてから数分かかります。） 

3. スキャンコントロールソフトを立ち上げます。 

4. スキャナの初期化が始まりますので、初期化が終わるまで待ちます。 

5. スキャンコントロールソフトの画面右下にある Scanner Status が Ready になることを確認します。 

※デフォルト設定では、Ready の状態で 5 分間、スキャン開始せずに待機すると、省電力のためレーザ

ーが OFF になります。スキャンのために Queue に入れるとレーザーが自動点灯し、Status が Ready に

なります。 

 

 

いずれのスキャナでも、スキャン後はスライドフォルダを取り出し、コントロールソフトを閉じてください。その

後スキャナおよび PC の電源を落としてください。 

 

通信エラーが起きた場合などは、PC とスキャナの電源を切った後 10～15 分ほど待ち、上記手順で PC とス

キャナの再起動をお試しください。それでも改善しない場合は、エラー内容を弊社サポート窓口までお知ら

せください。 
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Appendix4：Feature Extraction 用デザインファイルのダウンロードサイト 

デザインファイルは eArray からダウンロードすることができます（ご使用の際、ご登録が必要となります）。 

【eArray】 http://www.chem-agilent.com/contents.php?id=29443 

 

1．お使いのマイクロアレイのデザイン番号 (Design ID)を確認します。 

デザイン番号： マイクロアレイのラベルに記載されてい

る 12 桁の番号の「25」に続く 5 桁の番号の頭に「0」を付

けた 6 桁の番 号。この 12 桁の番 号は Feature 

Extraction の出力ファイルからも確認できます。 

例） 12 桁の番号が 251469312345 の場合 

[14693]の頭に「0」を付けた 014693 

 

2．eArray にログイン後、画面右上の 

「Application Type」を Expression に変更 

 

 

 

 

 

3．Home タブで Microarray にチェックを入れ、 

Design ID欄にデザイン番号を入れてSearch。 

 

 

 

 

 

4. Search 結果から「Download」を選択 

 

5. Internet Explorer の Pop Up Blocker 

を Off にし、 「EXTERNALFULGEML」 

（＝Feature Extraction 用デザインファ 

イル）をダウンロード 

http://www.chem-agilent.com/contents.php?id=29443
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Appendix5：Feature Extraction 用 Protocol のダウンロードサイト 

弊社スポット数値化ソフトウェア、Feature Extraction によるスポットの数値化を行う際、イメージの数値化

に適用する解析アルゴリズムを設定した Protocol ファイルが必要です。 

Agilent が推奨している Default 設定の Protocol ファイルは、下記サイトからダウンロードが可能です。 

http://www.genomics.agilent.com/article.jsp?pageId=2037 

 

 

 

 

※ 2017 年 4 月現在、上記の Protocol のダウンロードが可能です。 

※ プロトコルファイルは、最新のものではなく、お使いの Feature Extraction Software と一致したバ 

ージョンをお使い下さい。 

※ 各 Protocol の詳細は、Protocol Use のリンク先をご参照下さい。 

http://www.genomics.agilent.com/article.jsp?pageId=2037
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Appendix6：マイクロアレイのレイアウト 

キットに付属のデザインファイルには、アレイの各プローブの位置情報（レイアウト）やアノテーション情報が含ま

れております。このデザインファイルは、アジレント DNAマイクロアレイスキャナで読み取った向きを基準として作

成されております。弊社のスキャナはアレイ面を裏側にから、またバーコードを左位置で読み取るので、ほとんど

の他社製品のスキャナで読み取ったイメージと向きが異なります。数値化データとプローブ情報を組み合わせる

際には、お使いのスキャナの読み取り方向にあわせて並び替えたデザインファイルをお選び頂く必要があります。

並び替えたデザインファイルも eArray からダウンロードできますので、次の点をよくご確認したうえ、適切なデザ

インファイルをお使いください。 

 

 

1) アレイの表面側(front side)からスキャンしているか。(バーコードにAgilentの文字がある側からスキャン) 

2) 得られたイメージ画像が、スライドグラスを横方向（landscape）にスキャンしたものか。 

縦方向（portrait）にスキャンしたものか。 

バーコードが得られたイメージに対して、上下左右のどこに位置しているかでご判断ください。 

デザインファイル名には、アレイ種類（Design ID）とファイル更新日の情報が含まれております。 

 

デザインファイル名の例： 

 

 

 

 

 

 
(Design ID) 
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Appendix7：弊社 DNA マイクロアレイサポート用ホームページ 

弊社の DNA マイクロアレイサポート用ホームページでは、新製品や最新プロトコル、アプリケーションノートなど

様々な情報を掲載しております。 

(アメリカ本社ウェブサイト)  http://www.genomics.agilent.com/en/home.jsp# 

本社のサイトに掲載してありますキャンペーンの中には、日本国内ではご利用いただけないものもございますこ

とをご了承ください。 

 

アジレントゲノミクス 日本ウェブサイト 

 

 

 

 

 

 

 

 

 

 

http://www.agilent.com/chem/genomics:jp 

 

• eArray  

• 実験に必要なものリスト 

• サポートページ 

サポートページにて、最新版の和文マニュアルを 

ダウンロードすることができます。 

http://www.agilent.com/chem/genomics:jp
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Copyright Agilent Technologies 2017 

すべての権利は留保されています。著作権法で認められている場合を除き、本書を許可なく複製、改作、

翻訳することは禁止されています。 

 

本和文操作テキストの版権は全て Agilent Technologies, Inc.が所有しています。 

 

ご注意 

本書に記載した内容は、予告なしに変更することがあります。 

本書は、内容について細心の注意をもって作成いたしましたが、万一ご不審な点や誤り、記載もれ等、お気

づきの点がございましたら当社までお知らせください。 

当社では、下記の項目を補償の対象から除外いたします。 

ユーザーの誤った操作に起因する機器などの損傷、性能上のトラブル、損害 

本キットの本来の用途以外の使用に起因する機器などの損傷、性能上のトラブル、損害 

本プロトコルに以外の方法または試薬を用いたことによる性能上のトラブル、損害。 

 

分析結果に基づく損失 

本書の内容の一部または全部を無断で複写、転載したり、他の言語に翻訳したりすることは法律で禁止さ

れています。複写、転載などの必要が生じた場合は、当社にお問い合わせください。 

本製品パッケージとして提供した本マニュアル等の媒体は本製品用にだけお使いください。 

 

保証 

本書に記載した内容は、予告なしに変更することがあります。 

Agilent Technologies は、本品に関していかなる保証も行いません。これには暗黙の保証、または商品性

および特定目的への適合性が含まれますが、それらに限定されません。 

Agilent Technologies は、本書に含まれている誤植、あるいは本品の性能、または使用に関する偶発的な

いし間接的な損害に関して責任を負いません。 

 

 


